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BAB1
PENGENALAN LIBREOFFICE.org

1.1. Pengenalan LibreOffice.org

Open Source adalah software dengan kriteria sebagai berikut :

1. Distribusi ulang yang tidak terbatas. Software open source dapat didistribusikan
ulang baik secara gratis maupun dengan mengambil keuntungan.

2. Source code. Sumber kode dari software harus tersedia

3. Pekerjaan lanjutan. Source code dapat digunakan untuk membuat pekerjaan

berikutnya.

LibreOffice.org adalah sebuah paket aplikasi perkantoran berkode sumber terbuka (open
source) yang dapat diperoleh secara gratis. Paket tersebut termasuk komponen-
komponen pengolah kata, pengolah angka, presentasi, drawing, dan gudang data.
LibreOffice.org dapat berjalan di platform mulai dari Windows 95 atau lebih baru,
Linux, Solaris dan Mac OS X. LibreOffice.org menyediakan banyak bahasa seperti
Perancis, Spanyol, Portugis, China (tradisional dan simplified), Italia, Jepang, Hindi,
Roma, Thai, Danish, Belanda, Indonesia dan sebagainya. Tersedia dukungan teknis
yang berkualitas tinggi dan gratis berkat mailing list dan forum yang dijalankan oleh
sukarelawan.

Tabel 1.1 Paket dalam aplikasi LibreOffice.org :

Aplikasi LibreOffice.org
Pengolah kata Word Processor
Pengolah angka Spreadsheet
Paket presentasi Presentation
Sistem manajemen database Database
Drawing Draw
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1.2. Kelebihan LibreOffice.org

Berikut kelebihan-kelebihan LibreOffice.org :

1. Tidak ada biaya lisensi
LibreOffice.org bebas digunakan dan bebas didistribusikan.

2. Open source
Pengguna dapat mendistribusikan, menyalin serta mengubah perangkat lunak sesuai
dengan kebutuhan.

3. Cross-platform
LibreOffice.org dapat dijalankan diberbagai platform hardware dan sistem operasi
seperti MS. Windows, Mac OS X dan Linux.

4. Dukungan multibahasa
LibreOffice.org mendukung berbagai bahasa (lebih dari 40 bahasa), ejaan, hipenasi
dan thesaurus. Selain itu juga terdapat layout bahasa Complex Text Layout seperti
Hindi dan Arabic.

5. User interface yang konsisten
Semua komponen memiliki “look and feel” yang serupa, sehingga memudahkan
dalam penggunaan dan penguasaan perangkat lunak.

6. Terintegrasi
Seluruh komponen LibreOffice.org saling terintergrasi satu sama lain.

7. Granulariti
Jika mengubah opsi maka akan mengubah seluruh komponen. Walau begitu, opsi
dapat diatur pada setiap komponen atau dokumen.

8. Kompatibilitas file
LibreOffice.org mempunyai kemampuan untuk mengekspor dokumen ke format
PDF dan flash. Selain itu juga dapat digunakan untuk membuka dan menyimpan file
dalam format MS. Office, HTML, XML, Wordprefect dan Lotus123

9. Tidak terpaku pada satu vendor
LibreOffice.org menggunakan OpenDocument, file format XML yang dikembangkan
sebagai standar industri oleh OASIS (Organizations the Advancement Information
Standard). Sehingga file-file dapat dengan mudah dibuka dan dibaca oleh teks editor

lain.
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10.Berkontribusi
Semua pengguna dapat terlibat dalam proses pengembangan dan perbaikan

perangkat lunak. Hal ini dilakukan dengan bergabung ke dalam komunitas.

1.3. Modul dalam LibreOffice.org

Aplikasi office suite LibreOffice.org terdiri dari 6 modul yaitu :

1. Writer (Pengolah Kata)

Writer adalah modul yang digunakan untuk mengolah kata. Dokumen yang dapat dibuat
dengan writer diantaranya naskah, surat, buku, laporan, berita dan lain-lain. Format file
pada writer default-nya bereksistensi ODT namun dapat juga disimpan dengan format
lain seperti DOC, HTML, XHTML dan lain-lain.

2. Calc (Pengolah Angka)

Calc adalah modul yang digunakan untuk membuat lembar kerja. Dengan calc dapat
menganalisis, membuat grafik chart atau membuat keputusan yang dibantu oleh
berbagai fungsi untuk pengambilan keputusan. File lembar kerja yang disimpan
berekstensi ODS, namun calc dapat juga membaca dan menyimpan format file dengan
ekstensi XLS, CSV, DBF, HTML dan lain-lain.

3. Impress (Presentasi)

Impress adalah modul untuk membuat dokumen presentasi. Impress dilengkapi dengan
tool presentasi multimedia antara lain efek khusus, animasi dan gambar. File presentasi
secara default bereksistensi ODP namun bisa juga membuka dan menyimpan dengan
ekstensi lain seperti PPT dan dapat diekspor menjadi file Macromedia Flash (SWF)

4. Base (Basis Data)

Base adalah modul yang digunakan untuk membuat aplikasi basis data dengan
antarmuka yang menarik. Kemampuan base setara dengan MS. Access sehingga dapat
digunakan untuk membuat form, report, query, table, view dan relasi. Database yang
dapat dimanfaatkan oleh base cukup banyak seperti HSQLDB (default database
engine), dBase, Ms. Access, MySQL dan lain-lain.

5. Draw (Menggambar)

Draw adalah modul yang digunakan untuk menggambar. Gambar yang dihasilkan bisa

berupa diagram atau flowchart dan dapat digunakan untuk menggambar 3-D. File
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gambar yang dihasilkan dapat disimpan dengan format sekitar ada 20 format file
termasuk PNG, HTML, PDF dan Flash. Untuk membuat gambar pada modul.

6. LibreOffice.org lainnya dapat mengaktifkan dengan menggunakan tool dari toolbar
Drawing.

7. Math (Formula)

Math adalah editor formula atau rumus. Modul ini digunakan untuk membuat rumus
kompleks yang terdiri dari simbol-simbol atau karakter-karakter yang tidak ada pada
font standar. Math juga dapat diaktifkan pada modul LibreOffice.org lainnya atau
diaktifkan sebagai editor sendiri. File yang dibuat dapat disimpan dengan format standar
MathML yang memudahkan dalam menyajikan formula sebagai halaman web atau

untuk digunakan pada dokumen yang dibuat dengan perangkat lain.
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BAB I1
LIBREOFFICE.org WRITER

2.1. Antarmuka LibreOffice.org Writer
Antarmuka pada LibreOffice.org Writer terdiri dari Title bar, Menu, Toolbar, Ruler,

Area Kerja dan Status Bar.

2.1.1. Menu
Menu terletak pada bagian atas layar di bawah title bar. Menu utama terdiri dari File,

Edit, View, Insert, Format, Table, Tools, Window dan Help. Seperti gambar dibawah :

File Edit View Insert Format Table Tools Window Help
Gambar 2.1 Menu LibreOffice.org

1.  Menu File berisikan perintah-perintah yang berlaku pada seluruh dokumen seperti
Save, Open, Close, Wizard, Print dan lain-lain.

2. Menu Edit berisikan perintah-perintah untuk penyuntingan dokumen seperti Undo,
Find and Replace dan lain-lain.

3. Menu View berisikan perintah-perintah untuk mengontrol penampilan dokumen
seperti zoom dan web layout.

4. Menu Insert berisikan perintah-perintah untuk menyisipkan elemen dokumen
seperti  Header, Footer dan Picture.

5. Menu Format berisikan perintah-perintah untuk memformat dokumen seperti Style
and formatting, Page, Character dan Paragraf.

6. Menu Table berisikan perintah-perintah yang berhubungan dengan table seperti
menyisipkan dan menghapus table.

7. Menu Tools berisikan perintah-perintah yang berfungsi untuk membuat surat secara

N 5
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masal, spellcheck Options, Customize.
8. Menu Help berisikan link ke file help, check for update dan registration dan

informasi tentang versi yang sedang digunakan.

2.1.2. Toolbar

Standar tool

Panduan LibreOffice.odt — LibreOffice Writer
File Edit View Insert Format Table Tools Window Help
E-B-Holga v B- a a @ [ = q
[ | Default Style | v | Liberation Serif vz |~ & 4 A |EEE S EEE g - & E -

i

15 ' 16

\—{Formatting toolbar |

Gambar 2.2 Toolbar LibreOffice.org Writer

>

Berdasarkan gambar 2.2 diatas dapat di lihat susunan toolbar pada LibreOffice.org
Writer. Pada posisi paling atas adalah standard bar yang tampil pada setiap
LibreOffice.org. Pada baris kedua yaitu formatting bar, toolbar ini tergantung kepada

objek yang sedang aktif atau sedang dipilih.

2.2. Mengolah Dokumen
Fungsi utama LibreOffice.org writer adalah sebagai pengolah dokumen. Dokumen yang
diolah dapat berupa dokumen baru, dokumen lama dan dokumen hasil impor file dari

format yang berbeda.

2.2.1. Membuat dokumen baru

Langkah-langkah membuat dokumen baru adalah dengan cara:

1. Pilih menu File

2. Pilih New

3. Maka akan keluar beberapa pilihan untuk membuka dokumen baru
4. Pilih Text Document
5

Maka akan tampil dokumen baru
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6. Atau dapat dengan menekan dengan cara pintas CTRL+N

File Edit View Insert Format Table Tools Windo

e » ext Document Ctri+MN |
Opert... CErf+O Spreadsheet |
Recent Documents » Presentation
Wiz s . Drawing |
- Database !

Close 2 e

= e < HTMI Document
Sauve Ctri+S =
Save As... Ctri+Shifi+S XAIT. Forrm Document
Fesvie AL Master Docurment
Reload Formula

z Labels
Versions... =
Business Cards

Export... =
Export as PDF... Templates and Documents
Send »
Properties...

Drigital Signatures...
Templates »

Preview in Web Browser

Paoge Preview
Print... Ctri+P
Printer Sefttings...

Eoxcif CErf+0Q

Gambar 2.3 Membuat dokumen baru

2.2.2. Membuka File
Untuk membuka file dokumen yang telah tersimpan kita dapat melakukan hal berikut:
1. Pilih menu File pilih Open pada menu File atau pada toolbar standar, tekan tombol

Buka = .atau menu Berkas | Buka

File it Wie e Freserit

k:

o r=F e -

Qggéi_-. P
e i Ihaocrenrernts -

M izardads -

R anl]

Crose

Serrre T
Sare As. . el SR e sS
Serare AFL

Reload

Versiores. .

Eoc et

FExcprort as PI2F. .

Serada -
Frroprertios. .

Irigirtal Signaficres...

Terre prlates -
Freviers i Webh Bromwoser
Prage FPreuvieos

Frrirad . L or S =g

Prirter Seféirngs._.

Elacid TR

Gambar 2.4 Menu Buka Dokumen

- I
1~gartiin 7

[ = ]
T —
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2. Pilih folder tempat file yang akan dibuka tersimpan.
3. Setelah folder aktif, pada daftar nama-nama file akan terlihat file yang sudah

disimpan sebelumnya.
4. Pilih file yang akan di buka dengan format odt, klik tombol buka.maka dokumen

akan tampil pada jendela.

Open

7 < airputih | ownCloud ' Laporan Program

Size Meodified ¥

Places Name
Q, search HH Laporan Program ICT 4 Humanity dan Transparency.odt 41.3 kB 10/24/2014
53.4 kB 10/27/2014

& Recently Used Laporan Program ICT 4 Humanity dan Transparency.pdf
airputih

Desktop

] File System

@ Documents

Music

[ Pictures
&l Videos

B Downloads

all| [ All files

+! File type
Version:| Curre

Cancel

| Read-only

Gambar 2.5 Tampilan Kotak Dialog Buka Dokumen

2.2.3. Menyimpan Dokumen
File dokumen yang telah dibuat dengan menggunakan Libre Office Writer jika disimpan

akan memiliki extensi .odt sebagai defaultnya. Jika dibutuhkan, dokumen dapat
disimpan kedalam format Microsoft Word, html, text dan format lainnya. Latihan
berikut adalah untuk menyimpan dokumen sederhana yang sudah dibuat.

1. Klik Menu Berkas pilih save atau save as atau pada toolbar standar klik tombol save

h____.
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MNew
Open... Ctri+0O

Recent Documents
Wizards
Templates

Close

>

Save As... Ctrl+Shift+5
Sawve a Copy...

Sawve ALL

Reload

Versions...

Export...
Export as PDF...
Send

Properties...

Digital Signatures...
Prewview in Web Browser

Page Preview Ctri+Shift+0O
Print... Ctri+P

Printer Settings...

Exit LibreOffice Ctri+Qr

Gambar 2.6 Menu File-Save

2. Pada kotak Nama yang paling atas, ketikan nama dokumen yang akan disimpan.

3. Klik Save untuk menyimpan dan menutup kotak dialog Simpan.

Save

MName: Panduan LibreOffice|

Save in folder: <

Places

Q Search

) Recently Used
airputih

=] Desktop

[=J File System

Documents

Music
ictures
Videos

B Downloads

+| File type

Edit filter settings

" Save with password

& airputih | ownCloud || Edit Modul

Name
Menggambar dng GIMP.odt
Bekerja dengan Libre Office 2.odt

|=] Panduan LibreOffice.odt

AlL Formats

Create Folder

Size Meodified v
7.2MB 11/21/2014
5.1™MB 11/21/2014

88MB 12:47

Eagsel

R —

Gambar 2.7 Tampilan Kotak Dialog Penyimpanan Data
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2.2.4. Mencetak Dokumen

Setelah selesai menginput data di dokumen yang di ketik, maka tugas terakhir yang
harus dilakukan adalah mencetak dokumennya. Caranya adalah sebagai berikut:

1. Klik pada menu File

2. Pilih Print pada daftar menunya

FEiLe Edit Wie e Insert Format
Meww >
Open... Cerl+O

Recent Documents > =
WWizards >
Templates >

Close

Save Crrl+5S
Sawve As... Crri+Shift+5
Save a Copy...

Sawe ALL

Reload

Wersions...

Export...
Export as PDF.___
Send >

Properties...

Digital Signatures...
Prewview in Web Browser

Page Prewview Crrl+Shift+O

Printer Settings.._.

Exit LibreOffice Ctri+Q

Gambar 2.8 Menu Cetak
3. Pada kotak dialog, pilih jenis printer yang akan digunakan
4. Pada bagian pages, tentukan halaman yang akan dicetak
5. Apabila dokumen yang akan dicetak perlu rangkap maka pada number of copy ...
isikan dengan jumlah yang diinginkan

6. Klik Ok

Print

P
General | LibreOffice Writer | Page Layout | Options
- 8.26in (A4) Printer
Deskjet-1000-11 10-series

LaserJet-100-colorMFP-M1 7 5nw

+ Details Properties...

11690

Range and copies
& Al pages Number of copies |1 =
= Cottate [ HEE

Pages |18

) Selection
T Print in reverse page order
Print

1l v107 > Comments MNone (document only)

oK Cancel Help

Gambar 2.9 Kotak Dialog Cetak
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2.3.Memformat Dokumen

2.3.1. Page Setup

Page setup adalah pengaturan yang digunakan untuk mengatur halaman berupa ukuran
kertas, margin dan orientasi kertas. Langkah-langkah pengaturan tersebut sebagai
berikut :

1. Pilih Menu Format.

2. Pilih Page.

3. Maka akan tampil kotak dialog seperti di bawah ini.

= Page Style: Default
Organizer | Page | Background | Header | Footer| Borders  Columns | Footnote
Paper format
Formai |Ad rem|
Width |21.00cm 2l
Height |29.70cm 4
Orientation () Portrait
() Landscape Paper tray |{From printer settingsj * |
Margins Layout settings
Left |3.50cm :I Page layout iRight and left v |
P ——
Right 2.50cm = Format %2 3, . * |
Top |2.50cm - | | Register-true
[ ryl Reference Style
Bottom 2. 50cm - ! =
| OK | | Cancel || Help | | Reset |

Gambar 2.10 Mengatur Ukuran, Margin dan Orientasi

Untuk paper format :

* Format, digunakan untuk memilih jenis kertas yang akan digunakan
e Width, menentukan lebar kertas

* Height, menentukan tinggi kertas

* Orientation, menentukanorientasi kertas

Untuk margin :

* Left, untuk mengatur batas kiri kertas
* Right, untuk mengatur batas kanan kertas
* Top, untuk mengatur batas atas kertas

* Bottom, untuk mengatur batas bawah kertas

A 1
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2.3.2. Membuat Header dan Footer

Untuk menyisipkan header dan footer pada LibreOffice.org yaitu dengan cara :

Pilih menu insert kemudian pilih Header atau Footer.

1. Atau pilih menu Format Pilih Page.

2. Maka akan muncul kotak dialog Page Style.

3. Pilih tab Header untuk mengatur catatan kepala.

4. Pilih tab Footer untuk mengatur catatan kaki.

5. Beri tanda checkbox pada header on untuk mengaktifkan header dan footer on

untuk mengaktifkan Footer.

Page Style: DefFault

Organizer | Page | Background Header | Footer | Borders  Columns | Footnoke

Header
& same content left/right

Left margin 0.00cm =
Right margin 0.00cm =
Spacing 0.50cm =

| Use dynamic spacing
Height 0.50cm s
& AutoFit height

| More... |

ek | cancel || Help || Reset |

Gambar 2.11 Format Header

Page Style: Defaulkt

Organizer Page Background Header Footer Borders Columns Footnote

Footer

Same content left/right

Left margin 0.00cm =
Right margin 0.00cm =
Spacing 0.50cm =

Use dynamic spacing
Height 0.50cm =
B AutoFit height

.__More... |
[TJ | Cancel || Help || Reset |
Gambar 2.12 Format Footer
- -
o 1 g ]
12 Mgt
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2.3.3. Menyisipkan Keterangan Tambahan

2.3.3.1. Dengan menggunakan Header dan Footer

Pada dokumen yang bersifat resmi atau sebuah tulisan dari sebuah instansi, keterangan
tambahan biasanya diletakkan di bagian Header atau Footer. Keterangan tambahan
tersebut bisa berupa nama lembaga, judul, tanggal, ataupun nomor halaman. Contoh

seperti di bawah ini.

wangg,?&.ﬂ:é'% 13
L1 >

Gambar 2.13 Menyisipkan Keterangan Tambahan

Buka Dokumen

Bukalah dokumen yang akan diberi keterangan tambahan.

Menyisipkan Header

Anda bisa menyisipkan header dengan cara meng-klik Insert >> Header >> Default.

Maka ruang header akan tampil di bagian atas halaman.

B R = E R RS Vel e e )

(5| Header [ || Times New Roman [~ Jf12 [~ | B g \%

—esh Y2

(ENE 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 /iGgmS
S

=l

I k =
X LINUX =
o 8=
L 5

Linux (diucapkan 'Inoks atau /'lintks/)[1] adalah nama yang diberikan kepada sistem =)
o ‘operasi komputer bertipe Unix. Linux merupakan salah satu contoh hasil pengembangan

perangkat lunak bebas dan sumber terbuka utama. Seperti perangkat lunak bebas dan ,@
o sumber terbuka lainnya pada umumnya, kode sumber Linux dapat dimodifikasi, -

digunakan dan didistribusikan kembali secara bebas oleh siapa saja[2] AQ ]
I~

Nama "Linux" berasal dari nama kemelnya (kemel Linux), yang diperkenalkan tahun @B
[ 1991 oleh Linus Torvalds. Sistemnya, peralatan sisem dan pustakanya umumnya
L berasal dari sistem operasi GNU, yang diumumkan tahun 1983 oleh Richard Stallman, e

Kontribusi GNU adalah dasar dari muneulnya nama alternatif GNU/Linux. 3] = -
o

Linux telah lama dikenal unwk penggunaannya di server, dan didukung oleh @
= perusahaan-perusahaan komputer ternama seperti Intel, Dell, Hewlett-Packard, IBM,
ks Novell, Oracle Corporation, Red Hat, dan Sun Microsystems. Linux digunakan sebagai o
i sistem operasi di berbagai macam jenis perangkat keras komputer, termasuk komputer N =
B deskiop, superkomputer,[4], dan sistem benam seperti pembaca buku elektronik, sistem :
= permainan video (PlayStation 2, PlayStation 3 dan XBox[5]), telepon genggam dan wa
= router. Para pengamat teknologi informatika beranggapan kesuksesan Linux dikarenakan
Al L L Pl it B | i

DA =TevR, NSTTORN -0 MRS+ 2RO [ e (-S|

[Page1/1 | [Default I English (USA) |(inse] [smo (][] [CE@][o——e——o]|[80% ]

Gambar 2.14 Menyisipkan Header

m%fwmb‘t:?’“& 13
™ L |
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2.3.3.2. Mengatur Teks Header
Ketikkan keterangan yang akan dijadikan sebagai header. Ruang yang tersedia untuk

header biasanya sempit. Jadi Anda perlu mengatur ukuran huruf agar bisa sesuai.

e = R = I k-APS

E?Z'@f\“'y' NEEN o= e a2

» = LI Ll B A UIS ===
[T X 1 2.3 4567 -8 ;9 10 1L 12131415 .16 17 J18 10 ] ~
— i
; g
L =
- Scjarah LTS ~ —
- S
: =]
o =
” Linux (diucapkan 'llnaks atau /'lmoks/)[1] adalah nama yang diberikan kepada sistem —
L operasi komputer bertipe Unix. Linux merupakan salah satu contoh hasil pengembangan ‘q .
. perangkat lunak bebas dan sumber terbuka utama. Seperti perangkat lunak bebas dan
o sumber terbuka lainnya pada umumnya, kode sumber Linux dapat dimodifikasi] %
- digunakan dan didistribusikan kembali secara bebas oleh siapa saja.[2] o
. Nama "Linux" berasal dari nama kemelnya (kernel Linux), yang diperkenalkan tahun iy
£ 1991 oleh Linus Torvalds. Sistemnya, peralatan sistem dan pustakanya umumnya B
L berasal dari sistem operasi GNU, yang diumumkan tahun 1983 oleh Richard Stallman/ 1
: Kontribusi GNU adalah dasar dari munculnya nama alternatif GNU/Linux.[3] —
= . ' . ) a
- Linux telah lama dikenal untuk penggunaan di server, dan didukung oleh
= N O | il Tt Dot DAL
< + -
iAo T UG -@-& {l-8 -3l TR |
[Page1/1 | [Default [ English (USA) ] [nsrT][s7o ][] [ J[GERD | [@—+—o—— ][100%]

Gambar 2.15 Menyisipkan Teks pada Header

2.3.3.3. Menyisipkan Footer
Selain menyisipkan header, Anda juga bisa menyisipkan footer dengan cara yang tidak

jauh berbeda. Klik menu Insert >> Footer >> Default.

2.3.3.4. Teks Otomatis
OpenOffice.org Writer menyediakan teks otomatis yang bisa Anda manfaatkan untuk
header dan footer. Klik menu Insert >> Fields dan pilih item yang akan digunakan untuk

footer.

2.3.3.5. Page Style
Selain dari menu Insert, Anda juga bisa mengatur header dan footer melalui Page Style.

Klik menu Format >> Page dan pilih tab Header atau Footer.

14
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Header

Same content left/right

Left margin 0.00cm

|
a

Right margin
spacing &

[l Use dynamic spacing

Height 0.10cm

o)

AutoFit height

[ OK J| Cancel || Help || Reset

Gambar 2.16 Page Style Header

2.4. Penomoran Halaman

Langkah-langkah untuk menyisipkan nomor halaman pada dokumen yaitu :
1. Header atau Footer harus sudah ada pada dokumen.

2. Tempatkan kursor pada Header atau Footer.
3. Kemudian klik menu Insert

4. Pilih Field

5. Pilih Page Number

Insert Format Table Tools Windows  Help
Manual Break... aec [ 2
I o
Special Character... Time

Formatting Mark > Page Number

Page Count
Subject

TitLe
Header > Author

Section...
Hyperlink Cri+k

Footer >
Footnote/Endnote... Other... CtrL+Fg
Caption.__.

Bookmark...

Cross-reference...

Comment Ctri+Alt+C

Script...

Indexes and Tables >
Envelope...

Frame...

Table... Crri+F12
Image >
Mowvie and Sound...
Object >

Floating Frame...

File... R —— R

Gambar 2.17 Penomoran Halaman

- -
it
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2.5. Pengaturan Paragraf

2.5.1. Merapikan Paragraf

Untuk merapikan paragraf pada dokumen adalah sebagai berikut :

1. Blok paragraf yang akan dirapikan.

2. Pilih menu Format.

3. Pilih Paragraph.

4. Pilih tab Alignment.

5. Untuk pengaturan teks pada paaragraf tersedia jenis perataan dengan memilih pada
tulisan Option kemudian Left, Right, Center atau Justify.

6. Kemudian pilih Ok.

Paragraph

Outline & Numbering Tabs Drop Caps Borders Background
r 1
Indents & Spacing Alignment Text Flow §
Options |
Left
Right
Center
@ Justified
|
Last line: Left ~
|
Expand single word
]

¥ Snap to text grid (if active)

Text—to—text

Alignment: Automatic v

OK Cancel Help Reset

Gambar 2.18 Merapikan Paragraf

2.5.2. Mengatur Jarak antar Baris

Untuk mengatur jarak antar baris ikuti langkah-langkah dibawah ini :
1. Pilih menu Format.

2. Pilih Paragraph.

3. Pindahkan tab Indent & Spacing

16
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Paragraph
Outline & Mumbering Tabs Drop Caps Borders Background
( Indents & Spacing I Alignment Text Flow |
Indent ]
Before text: 0.64cm : I
After text: 0.00cm : |
First line: -0.64cm :
e I
S —
Above paragraph: 0.00cm : —
Below paragraph: 0.00cm :
Don't add space between paragraphs of the same style
Line spacing
1.5 lines » | of
1
Register—true
Activate
OK Cancel Help Reset

Gambar 2.19 Mengatur Jarak antar Baris

4. Pilih pengaturan line spacing untuk mengatur jarak antar barisnya yang mempunyai
pilihan single, 1,5 lines, double, propotional, at laest, leading atau fixed.

5. Untuk mengatur indentasi pada paragraf bisa diatur pada bagian Indent. Dengan
mengisi nilai jarak pada masing-masing field pada before text dan after text sesuai
dengan kebutuhan.

6. Pada Spacing bisa digunakan untuk mengatur jarak antar spasi paragraf. Isi nilai
pada Above paragraph dan Bellow paragraph.

7. Kemudian pilih Ok untuk menutup kotak dialog Paragraph.

2.6. Format Huruf

2.6.1. Memilih Tipe Huruf

Untuk mempercantik dokumen salah satunya adalah menentukan tipe huruf yang
dipilih. Untuk memilih tipe huruf dengan cara :

1. Pilih menu Format.

2. Pilih Character .

17
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[
Font | Font Effects | Position
Family

Liberation Serif

Liberation Serif

LKLUG

Lohit Assamese
Lohit Bengali
Lohit Devanagari
Lohit Gujarati
Lohit Kannada
Lohit Malayalam

Language |“% English (USA)

Character

Hyperlink | Background | Borders

Style Size
Regular 12
5
Bold 10
Italic 10.5
l Bold Italic 11
13
14
15

~

The same font will be used on both your printer and your screen.

Liberation Serif.

OK Cancel Help

Gambar 2.20 Kotak Dialog Character

3. Pilih tipe huruf dan ukuran huruf pada tab Font.

4. Kemudian tekan tombol Ok.

2.6.2. Membuat Efek pada Karakter

Reset

Untuk lebih memperindah karakter, dapat ditambahkan dengan cara sebagai berikut :

1. Pada kotak dialog Character pilih tab Font Effect.

2. Pilih effect sesuai dengan yang dibutuhkan, kemudian klik Ok.

18

Character

T
Font | Font Effects | Position | Hyperlink | Background | Borders

Options

Font color

T

Effects

(Without) ~
Relief

(Without) ~

Outline
T Shadow
) Blinking

Hidden

Owverlining Ovwverline color
(Without) bl [ ] Automatic
Strikethrough

(Without) ~

Underlining Underline Color

(Without) ~ Automatic

71 Individual words

Liberation Serif.

oK Cancel Help

Gambar 2.21 Tab Font Effect

Reset

‘____.
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2.7. Membuat Daftar dengan Bulets & Numbering
Kita bisa memanfaatkan Bullets dan numbering untuk membuat sebuah daftar maupun
susunan kegiatan dengan rapi. Anda bisa menggunakan urutan angka, huruf, serta

simbol dalam gaya pengurutannya.

2.7.1. Buat Daftar
Buatlah dokumen baru melalui LibreOffice.org Writer, lalu ketikkan item-item secara
berurutan ke bawah pada dokumen tersebut. Lalu arahkan kursor ke bagian kiri

dokumen dan sorot/blok semua teks.

ew Insert Formal

AR S ER - A S )RR [ VI Yo e 2 )
7 d [ Default ‘VHT\msNewRuman ‘VHIZ |~4‘ B ] u|7 = = %g:i%%‘&'g'g'l

o] 1 %1234 5 6.7 8.9 10 11 12,13 14 15 16 .17 J18 19| A
; Daftar Pesanan Oleh-Oleh Keluarga :

. Mobil RC

~

- Tamiya

¥ Robot Transformer

g Netbook

i Kacamata MP3

in

. Flashdisk 16GB

H DVD Blank | Box

M Mouse Infrared

5 Celana Jeans Runa

C? Jaket Rang| ‘

a Souvenir Khas Gresik

o Z
— —
: A
o (o]
s« *
Pagel/1 Default English (USA) ED OM|o——e |

Gambar 2.22 Daftar pada Dokumen

2.7.2. Aktifkan Bullets & Numbering
Klik tombol Numbering On/Off pada Object Bar untuk mengurutkan dengan angka atau

klik Bullets On/Off untuk menggunakan penanda lain. Anda juga bisa membuat

penanda sendiri.

19
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nsert Form

(SR~ =SS

Help

D&l =0

B DN Tl ER el )
5 b Default [~ Times NewRoman [~ {22 |-]E B u\g = %\:;{-\E{g\l&vg-@vl
o S z . IA‘ 2 2t a ‘Aﬂ " § . ﬁl‘ 7 D 8 ‘LQ " IJD " llA‘ 1. 7benr:g"0n/2)‘ﬂ‘ lﬁL‘ 17- 118 19- |

Daftar Pesanan Oleh-Oleh Keluarga :

Mobil RC

Tamiya

Robot Transformer
< Netbook
Kacamata MP3
Flashdisk 16GB

i DVD Blank 1 Box
,; Mouse Infrared
Celana Jeans Runa
Jaket Rana

G Souvenir Khas Gresil|

.10 .

L

@l <

< @

R RREEEEEEEEA—AA—A—ASI—S§—§9—§—§—a—€———anyujn >
Gambar 2.23 Blok Daftar pada Dokumen

2.7.3. Mengatur Format Numbering
Untuk mengatur formatnya, Anda bisa meng-klik menu Format >> Bullets and
Numbering sehingga muncul kotak dialog. Klik tab Bullets dan pilih salah satu dari

yang tersedia di dalam kotak tersebut.

IBUJII'E':5| Numbering type | Outline | Graphics | Position | Options.

ction
. |
. |
. |
-> v
-> v
-> v
| ok ||Remove || cancel || Help || Reset

Gambar 2.24 Kotak Dialog pada Tab Bullet

2.7.4. Menggunakan Simbol Grafis

Apabila Anda ingin menggunakan simbol lain, pilih tab Graphic. Di sini tersedia

20
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beraneka grafik warna-warni. Pilih yang Anda sukai.

Bullets. _Wumbering type Outii.ne|Graphirl:s|Pasi.ti.nn Options

Selection

@ > * &
@ > | * “
@ > | *
- @ ¥ 4
L @ + a
L @ + a
#* |+ @ +
* il = @ »
* ;’usn’libfopencffice.fbasiSB,l,l’sharefgallery}bullets;’redstar,gif‘b

| = I v

Link graphics
| oK | | Bemove | | Cancel | | Help | | Beset

Gambar 2.25 Kotak Dialog pada Tab Graphic

2.7.4. Model Penomoran

Jika Anda ingin menggunakan model penomoran (angka amupun huruf), Anda bisa
memilih tab Numbering type. Di sini terdapat beraneka model penomoran dengan
menggunakan angka, huruf, serta angka romawi. Pilih yang sesuai kebutuhan Anda.

Builer_'=.|Numberil'lg typElDutii.ne Graphics. Fosition. | Options.

|1) 1. (1) .
2) 2. (2 ]
3) 3. oy
Y J— @) ]
B) b) (b) i,
C) ) (c) iii.

| oK ||Bemove || Cancel || Help || Reset

Gambar 2.26 Kotak Dialog Tab Numbering Type

Qirourtiin 21
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2.7.5. Mengatur Jarak

Jarak antara angka/simbol pada Bullets and Numbering dapat diatur dengan cara
mengklik tab Position. Masukkan angka di kotak Numbering alignment, Aligned at dan
Indent at. Setelah itu, klik tombol OK.

\Bullets/ Numbering type.| Outline, Graphics,| Position Options,

Position and spacing
Level
Numbering followed by |Tab stop O |
2 e
3 at [1L.27em S
a il LA
5 Numbering alignment |Left 2 |
6 _—
7 Aligned at (0.64cm &
g Indent at L27em [0
10
1-10 r
1
1
| Default |
| oK ||Bemoue || Cancel || Help || Reset |

Gambar 2.27 Kotak Dialog Tab Position

2.8. Style

Style berupa kumpulan huruf atau pengaturan tampilan pada dokumen. Fitur-fitur pada
style berupa :

1. Paragraf : Format seluruh paragraf

2. Karakter : Format satu karakter atau lebih

3. Frame : Format frame untuk teks dan grafik

4. Page : Format struktur dokumen

5. Numbering : Format number dan bullet

2.8.1. Memanfaatkan Style
Untuk menggunakan Style and Formatting dengan cara :
1. Pilih Format

.

= -
22 gt

R —
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2. Pilih Style and formatting

3. Atau dengan menekan tombol F11.

4. Maka akan muncul kotak dialog seperti dibawah :

™ sStyles and Formatting
in] £2] £ f0O 8a 1= ~

Complimentary close
Defaulk

First line indent
Hanging indent
Heading
Heading 1
Heading 10
Heading 2
Heading 3
Heading 4
Heading 5
Heading &
Heading 7
Heading 8
Heading 9

List Indent
Marginalia

Text body indent

Automatic —

Gambar 2.28 Kotak Dialog Style and Formatting

5. Untuk memanfaatkan Style and Formatting bisa digunakan dengan cara :

a. Setiap melakukan pengetikan teks baru pilihlah Style yang akan digunakan dari
kotak dialog style and formatting.
b. Sedangkan untuk teks yang sudah ada, diblok dulu teks yang akan di format

kemudian pilih style and formatting yang akan digunakan.

2.8.2. Membuat Style Baru
Untuk membuat style baru ikuti langkah-langkah berikut iini :

1.

Pada kotak dialog style and formatting klik kanan

2. Kemudian pilih new, maka akan muncul kotak dialog paragraph style.
3.
4. Kemudian Ok.

Isi field name dengan nama style yang baru.
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@ Styles and Formatting
1] f2] £ ol (GR

Complimentary close
Default

First line indent
Hanging indent
Heading

Heading 1

Heading 10
Heading 2

Heading 3

Heading 4

Heading 5

Heading 6

Heading 7

Heading 8

Heading 9

List Indent
Marginalia
Sinature

Outline & Numbering Tabs Drop Caps Background Borders Condition
Organizer | Indents & Spacing | Alignment = TextFlow | Font | Font Effects = Position

Name Untitled1 AutoUpdate

Next Style [Untitled1

Linked with | Text body

Category | Text Styles

Contains

| Automatic

| Ok || Cancel || Help | Reset || Standard |

Gambar 2.29 Membuat Style Baru

2.8.3. Memodifikasi Style

Untuk merubah dan mengatur style yang sudah ada dapat dengan cara :
1.
2.

Dari kotak dialog style and formatting klik kanan pilih modify.

Maka akan muncul kotak dialog Paragraphh style.

Pada kotak dialog style yang sudah dipilih akan dapat dirubah pada tab yang ada di
kotak dialog. Tab yang ada pada kotak dialog style and formatting adalah Indent &
Spacing, Alignment, Text Flow, Font, Font Effect, Position, Numbering, Tabs, Drop
Caps, Background, Borders dan Condition.

Kemudian tekan Ok.

™ Styles and Formatting
i 2] 1 o) & v

Complimentary close
Default

Tabs
Alignment

Borders
Position

Outline & Numbering

Drop Caps
Text Flow

Background

Organizer | Indents & Spacing Font | Font Effects

First line indent
Hanging indent
Heading
Heading 1
Heading 10
Heading 2
Heading 3
Heading 4
Heading 5
Heading 6
Heading 7
Heading 8
Heading 9
List Indent
i iarginalis]

| Automatic

|

24

Options
@® Left
Right
Center
Justified

Last line Left

Expand single word

Text-to-text

Alignment |Automatic

[ ok |[ cancel || Help || Reset |[ standard |

Gambar 2.30 Modifikasi Style
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2.9. Tables

2.9.1. Menyisipkan Table

Untuk menyisipkan tabel pada dokumen dengan cara :
1. Pilih menu Table.

2. Pilih Insert.

3. Pilih Table.
4

. Kemudian akan muncul kotak dialog table.

Insaert Table

SGanaeral

Mame: TablLe4g
Colummns: =2 : Rowws: =2 ::
O pticons

Heading
Repeat Heading Rowws on neww pages

Heading Rowws: il

Don't split table over pages
= Border

SAutoFormat

Help Insert Cancel

Gambar 2.31 Kotak Dialog Table

4. Isi kotak dialog sesuai dengan kebutuhan.

5. Kemudian klik Insert.

2.9.2. Menambah Kolom

Untuk menambahkan kolom pada tabel yang sudah ada pada dokumen dengan cara :
1. Tempatkan kursor pada kolom yang akan ditambahkan.
2. Pilih menu Table.

3. Pilih Insert.

4. Pilih Column.

5. Tentukan jumlah dan posisi kolom yang akan disisipkan.
6

. Kemudian klik Ok.
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Insert Columns

Insert

¥

Number: |[1

{

Position
@ Before
After

Ok Cancel Help

Gambar 2.32 Kotak Dialog Insert Column

2.9.3. Menambah Baris

Untuk menambahkan baris pada tabel yang sudah ada pada dokumen dengan cara :
1. Tempatkan kursor pada kolom yang akan ditambahkan.
2. Pilih menu Table.

3. Pilih Insert.

4. Pilih Rows

5. Tentukan jumlah dan posisi kolom yang akan disisipkan.
6

. Kemudian klik Ok.

Insert Rowws
Insert

Mumber: 1

{)

Position
@ Before

After

O Cancel Help

Gambar 2.33 Kotak Dialog Insert Rows

2.9.4. Menghapus Kolom
Untuk menghapus kolom tertentu bisa dilakukan dengan cara :

1. Tempatkan kursor pada kolom yang akan dihapus, jika ingin menghapus lebih dari
satu kolom blok sebanyak kolom yang akan dihapus.
2. Pilih menu Table.
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3. Pilih Delete.
4. Pilih Column.

2.9.5. Menghapus Baris

Untuk menghapus baris tertentu bisa dilakukan dengan cara :

1. Tempatkan kursor pada baris yang akan dihapus, jika ingin menghapus lebih dari

satu baris blok sebanyak baris yang akan dihapus.

2. Pilih menu Table.
3. Pilih Delete.
4. Pilih Rows.

2.10. Merge dan Split
2.10.1. Merge

Cara menggabungkan kolom atau baris pada LibreOffice.org adalah dengan cara :

1. Pilih kolom atau baris yang akan digabungkan.
2. Pilih menu Table.
3. Pilih Merge Cells.

MNo. Mama Tempat Lahir Tanggal Lahir
l Indahsan Jakarta 30 December 1899
2 |Indah Nurul Jakarta 07 April 1994
3 |Indah Me Jakarta 24 Mey 1984
4 Amanda Jakarta 07 July 2007
5 Septi Survani Purworejo 28 September 1986

Gambar 2.34 Tabel Sebelum di Merge

Mo Nama Tempat Lahir Tangeal Lahir
I Indahsar Jakarta 30 December 1899
2 |Indah Nurml Jakarta 07 April 1994
3 |Indah Me Jakarta 24 Mey 1984
4 Amanda Jakarta 07 July 2007
5 | Sept Suryani Purworejo 28 September 1986

Gambar 2.35 Tabel Sesudah di Merge
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2.10.2. Split

Cara memisahkan kolom atau baris pada LibreOffice.org adalah dengan cara :
1. Pilih kolom atau baris yang akan digabungkan.

2. Pilih menu Table.

3. Pilih Split Cells.

I Indahsar Jakarta 30 December 1899
2 |Indah Nurul Jakarta 07 Apnl 1994

3  |Indah Me Jakarta 24 Mey 1984

4 Amanda Jakarta 07 July 2007

5 | Seph Suryani Purworejo 28 September 1986

Gambar 2.36 Tabel Sebelum di Split

Mo Mama Tempat Lahir Tanggal Lahir
l Indahsar Jakarta 30 December 1200
2 |Indah Numl Jakarta 07 April 1994
3 |Indah Mei Jakarta 24 Mey 1984
4 Amanda Jakarta 07 July 2007
5 Septi Survani Purworejo 2% September 1986

Gambar 2.37 Tabel Sesudah di Split

Perlu diingat pada saat proses pemisahan cell, harus merapikan kembali hasil dari split.
Karena cell yang sudah dipisahkan tidak sesuai dengan format cells yang ada diatas dan

bawahnya.

2.11.Formula

Cara menghitung formula pada LibreOffice.org dengan menggunakan tabel. Ikuti
langkah-langkah berikut :

1. Tempatkan kursor pada bagian kolom atau baris untuk tempat jumlah.

2. Kemudian pilih menu Table.

3. Pilih Formula.

4. Maka akan muncul toolbar untuk menginput rumus.
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R fo = ¥ J =5

Gambar 2.38 Toolbar Input Formula
No. Nama Nilai 1 | Nilai 2 | Nilai 3 Jumlah
1 Asih 70 70 70 210
2 Indah 80 80 80 240
3 Sakra 75 75 75 225
4 Somat 90 90 90 270
5 Lisdah 85 85 85 255

Gambar 2.39 Daftar Nilai

2.12.Menyisipkan Gambar

Dalam memasukan gambar ke word lebih baik menggunakan metode from file daripada

copy-paste. Hal ini untuk mencegah kekacauan atau gambar tidak muncul ketika

dokumen dibuka di komputer lain. Tahap memasukan gambar adalah :

1. Pilih menu Insert.
2. Pilih Image.
3. Pilih From File.

. ”‘f‘.
1T —. %]}

Insert Format Table Tools Window Help
Manual Break... nec, ] - A'i
Fields >
Special Character... - 1z -
Formatting Mark >3 1
Section._. Dalam mermasu
Hyperlink Carl+k copy-paste. He

Header > dolkumen dibulk
1. Pilih menu

2. Pilih Picture

Footer >
Footnote/Endnote...
Caption... 3. Pilih From ]
Bookmark...

Cross-reference. ..

Comment Ctrl+Alt+C

Script...

Indexes and Tables >

Envelope...

Movie and Sound... Scan >
Object > Fontweork Gallery...
Floating Frame...

File... S ——C

Gambar 2.40 Menu Insert Picture
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4. Kemudian akan muncul kotak dialog untuk insert picture.

Insert Image

Bt < | BHairputih | ownCloud  Edit Modul

Places Name Size Modified ~

QU Search Save as.png 64.5 kB 13:a8

@ ey s Print.png 34.8 kB 12:52

_ Print Ok.png 58.0 kB 12:56

airputih
Sisip footer.pn 5.6 kB 13:02

B Desktop = P prg
Insert Page.png a7.7 kB 13:05

=] File System
Paragraph.png 47.3 kB 13:09
Spasi.png 59.5 kB 13:11
karakter.png 51.3 kB 13:13

Bl font efek.png 50.32 kB 13:17

table.png 27.1 kB 13:30

B8 Downloads
inser table.png 12.4 kB 13:39
insert row.png 12.0 kB 13:40
Insert Image.png 56.0 kB 13:51

= = <AlL formats> >

+ File type

Style: Graphics ~
Preview

Insert as Link

Cancel Open

Gambar 2.41 Kotak Dialog Insert Picture
5. Kemudian pilih gambar yang akan dimasukan lalu klik Open.

2.13. Mengekspor Dokumen ke Format PDF

Dokumen pada LibreOffice.org dapat disimpan dan diekspor ke beberapa format. Salah
satunya adalah format file PDF. Langkah-langkah untuk menyimpan file dalam format
PDF adalah :

1. Pilih menu File.

2. Pilih menu Export.

3. Maka akan muncul kotak dialog seperti dibawah ini

Export
Name: Panduan LibreOffice
Save in folder: | < airputih | cwnCloud | Edit Modul Create Folder
Places Name Size Modified ~
T search 1.png A41.6 kB 12:25
& Recently Used = Open.png 957 bytes 12:36
airputih Open File.png S58.6 kB 12:41
8 Desktop Save.png 32.5 kB 12:a5
= File System Sawe as.png 64.5 kB 12:48
Documents Print.png 34.8 kB 12:52

Print Ok.png 58.0 kB 12:56
Pictures Sisip footer.png 5.6 kB 13:02
— T Insart Pans nna AT 7 LR 1305

o ALL Formats o~
= File type: PDF - Portable Document Format {.pdf)
AlL Formats iPg.ipeq.jfif.jif.jpe. pdf.png.xml
- Portable Document Format
JPEG - Joint Photographic Experts Group iPg.ipeq.jfif.jif.jpe
WWriter Layout XML semnL
Selection
Cancel Save

Gambar 2.42 Kotak Dialog Ekspor Format File ke PDF
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4. Kemudian klik Save.

2.14. Membuat Kolom

Seperti aplikasi pengolah kata pada umumnya, LibreOffice.org Writer memiliki fitur
untuk mengatur kolom pada sebuah halaman dokumen. Fitur ini berguna jika Anda
ingin memiliki dokumen dengan layout seperti surat kabar atau majalah. Agar tampilan

kolom jadi lebih menarik, Anda bisa menambahkan garis pembatas tiap kolomnya.

2.14.1. Menentukan Kolom

Bukalah dokumen yang akan dibuat menjadi kolom-kolom. Anda bisa mem-blok
tulisan/paragraf yang akan dibuat kolom atau membuat kolom sebelum mengetik
dokumen. Setelah paragraf di-blog, klik menu Format >> Columns.

Menentukan Jumlah Kolom

Setelah kotak dialog Columns muncul, Anda bisa menentukan jumlah kolom yang akan
digunakan dalam dokumen melalui kotak Column.

q Columns

Settings oK

Columns

o Cancel

1 1

i Apply to |Page Style: BAB Il Left ~ Help

i
Width and Spacing

Y]
(%

Celumn 1

Width

L - —

Spacing

AutoWidth

Separator line
1
i Style |- none - Height 1003 Color | Black

Width |0.25pt Position |Top

Gambar 2.43 Menentukan Kolom pada Dokumen

2.14.2. Mengatur Lebar Kolom

Setelah Anda memilih salah satu model kolom, Anda juga bisa mengatur lebar kolom
secara manual. Hilangkan tanda centang pada bagian AutoWidth dan atur lebar masing-

masing kolom beserta jarak antar kolom.
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Columns

Settings OK

Columns

— Cancel

2 %

Apply to | Page Style: BAB Il Right Heip
Width and Spacing

Column 2 2 3

Width 7.00em 7.00em

Spacing 1.00cm

# AutoWidth

Separator line

Style |-none- v | Height |100% Color - Black

Width |0.25pt Position |Top

Gambar 2.44 Mengatur Lebar Kolom

2.14.3. Memberi Garis Pembatas
Bagian Separator line berfungsi untuk memberikan garis pembatas antar kolom. Jika
Anda tidak menginginkannya, pilih None. Kotak Height berguna untuk mengatur tinggi

garis pembatas. Kotak Position untuk menentukan posisi garis di dalam kertas.

Columns

Settings oK

Columns

~ Cancel

2 w

Apply to Page Style: BAB Il Right ~ Help
Width and Spacing

Column 1 2 3

Width 7.00cm 7.00cm

Spacing 1.00cm

& AutoWidth

Separator line

Style - v | Height [100% : Color - Black o

Width 0.25pt .| Position |Top

Gambar 2.45 Menentukan Garis Pembatas Kolom
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2.14.4. Preview

Setelah pengaturan selesai, klik OK untuk menerapkan hasilnya. Untuk melihat hasilnya

secara menyeluruh, klik menu File >> Page Preview.

il = S LS w11 Q| oL ()| cese preview |

e ome 2

i
'\«H»M ()
B oo R s m i W

bl T o idabasgalil me Sy )
BV I Il N I = B mle—e———ol[4%]

Gambar 2.46 Preview Hasil Pemformatan Kolom

2.15. Mail Merge

Mail marge adalah sebuah fasilitas yang memungkinkan kita untuk membuat surat
untuk banyak orang tanpa harus mengetiknya satu per satu, dengan catatan kita harus
membuat data penerimanya pada dokumen lain terlebih dahulu.

1 Masukkan file database yang telah dibuat sebelumnya dengan masuk ke menu Edit

--> Fields

- .h 33
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2 Kemudian akan muncul tampilan seperti dibawah ini, klik tombol Browse untuk

memasukkan database-nya.

Trme Cwlabasa sk

sl ainge: sk + ! Bibliagragity R —
B Ol i I_ 1
1 i i
W
wr i
=l L
gt
aaaaaa
=
i
aH
dabed (b g rewna_ r& 1 -

Fomin

3. Setelah data masuk, kemudian klik tombol View --> Data Source untuk melihat

daftar database-nya

4. Setelah database-nya ada, langkah selanjutnya yaitu memasukkan field kolom

kedalam dokumen. Klik menu Insert --> Fields --> Other seperti gambar dibawah

ini :

- -
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k cuti Baru l.odt - LibreOffice Writer

irg. Andalusi Slamet
rg.Hetty Handayani,M.Kes

Titi inn
1 |':If 11 #

5. Kemudian pilih field yang ingin dimasukkan :

||:'I:-CHITI&"E Cmgg-nelenetags  Fencliorg  Doonformatka  Variatles Datsbacs

Tyipe Catabass selection

dny recond = & Bibliography i
1 Databass Mama o Data Cutl
| Mal mengs ek ~ ™ et culi
| Fiext recoed M
| Recoed noenbes HiF

Forag kea bl

! [abalan

ki databhpas file | m

T e ity

h
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6. Setelah field terisi selanjutnya tinggal menampilkan data kedalam dokumen dengan

menekan (klik) tombol Data to Field pada kolom data.

E = & TN = U = 4 = ] i
i LN | - el Tl |
! L4 g - .-‘-'1-'I!|
Lo B e | ry E - : -
. o Ly P OIS i, W13 Wk P Srrm ———
T e o P
=i gpry L
1 o i
Sl

7. Setelah itu dokumen siap dicetak.

2.16. Menyimpan Dokumen dengan Password

Password digunakan untuk melindungi dokumen yang disimpan oleh pengguna pc

ataupun jaringan. Pada LibreOffice.org Writer password digunakan sebagai pelindung

dokumen agar orang lain tidak berhak untuk melihat isi dokumen yang disimpan. Untuk

menyimpan dokumen dengan password, langkahnya sebagai berikut :

1. Pada saat dokumen akan disimpan pilih menu File | Save atau File | Save as, beri
tanda check box [v] pada pilihan save with password.

2. Ketik nama dokumen yang akan di simpan, kemudian tekan tombol Save, akan
muncul kotak dialog pengisian password. Isi password kemudian klik Ok.

3. Untuk mencoba dokumen yang di password, tutuplah dokumen yang disimpan
dengan password tersebut dan bukalah dokumen itu kembali. Kemudian masukkan
password yang diminta sesuai dengan password yang diketik pada saat

penyimpanan dokumen. Password jangan sampai lupa!!!

.
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= Save o=

Name | Untitled 1 |

¥ Browse for other folders

| = ||™™® airputih | Dncuments| | Create Folder|
Places Mame v | Size | Modified|*
@ Search = indah Friday

&) Recently Used » tutorialodt 1272 KB Friday

2 airputih

%= Desktop

B File s,kmme},alrputmmeskmp = Enter Password B

. 20 GBFilesyste.. Enter password

~ Documents
&= Music | e dedededed |
= Pictures
Reenter password
== Videos = p
== Downloads |ttttttttt| |

WARNING: If you lose or forget the passwaord, it
cannot be recovered. It is advisable to keep

L2 ]]<sc

Add| |Remove passwords in a safe place. Passwords are case-se..
» File type
[EJEdit filter settings [0] 4 || Cancel I Help |
(/] Save with password [
| Cancel | ‘ Save |

Gambar 2.64 Simpan dokumen dengan password

2.17.Menyisipkan Orientasi Halaman yang Berbeda

Adakalanya dalam pembuatan dokumen berisikan data yang disajikan dengan bentuk
format halaman yang berbeda. Misalnya pada halaman pertamanya dengan format
default yaitu potrait. Kemudian halaman berikutnya adalah format landscape. Berikut

adalah langkah-langkah untuk mengatur halaman dokumen dengan orientasi yang
berbeda :

1. Pilih Insert.

2. Pilih Manual Break.

3. Maka muncul kotak dialog Insert Break.

4. Pilih Style Landscape halaman untuk yang disisipkan.
5. Pilih Ok.

- L
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™ Insert Break

Type [
Line break
Column break | Cancel J

i®) Page break i - —
style | Help J

I e
-

|
Index -

Landscape
Left Page K. i |
Right Page -

Gambar 2.78 Insert Break

File

[EST) 12:55PM @ indahsari O

File Edit View [nsert Format Table Tools Window Help
\ T 5 5 — »
= | (e | | 4% - @ - | d -l m 1 g
5] | @ ‘ %% - IE1 | '\:4}‘1 32% | v 'Q%"'h | g Lg | Close Preview I

]

[s351/51

= ? 3 2 2| e N
I I I s e — A

Gambar 2.79 Tampilan Halaman yang Berbeda

2.18. Menyisipkan halaman menggunakan Manual Break
Langkah-langkah menyisipkan halaman :

1. Pilih Insert

2. Pilih Manual Break

3. Pilih Type dengan pilihan : Line break, Column break, page break
4

Pilih Style dengan pilihan : Default, envelope, first page, footnote, index, left page,
right page atau page style yang dibuat sendiri.

- L
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Insert Format Table 1 = Insert Break
w Break...
E; = Type oK
Fi Y
teigs ¢ O Line break
Special Character...
; () Column break Cancel
Formatting Mark b
®) Page break
Section... Help
o Style
Hyperlink : :
‘f{l\fnne} .
Header b [None] N
Footer b Cover ’
Footnote | Endnote... Defuult Q L
P Envelope ‘
Caption... First Page E
Gambar 2.80 Menu Insert — Manual Break
—..

:n:rhpt.rtlh
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BAB III
LIBREOFFICE.org CALC

3.1. Antar Muka LibreOffice.org Calc
LibreOffice.org Calc adalah aplikasi spreadsheet seperti Microsoft Excel. Ketika
pertama kali menggunakan Anda tidak akan menemukan banyak perbedaan dalam segi

tampilan. Berikut antar muka LibreOffice.org Calc.

> Applications Places otem MO E [ 1= M @4 -, = H30°C FriFeb 5, 10:09 AM ¢ ponyo

i‘ Untitled 1 - OpenOffice.org Calc ~ | %

e ew Insert Format .\e ow Help
F el Gl el e 1G22 8 Y - - @
=P BB |- -8 £ U] EE(}FE \@%%?"fm |@;i?£||:|'@.'§,'\l
ERR Rl v )
B | C [ D E F | G H [ | | ] | K L [ M | N S~
15
2
3
16
5
6
7
8
3 @
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30 @ )
[1e](«] [(v)p1/\Sheet I [ Sheet? [oheeis 7 |] < 3|
Sheet 1/3 Q_

Gl 5 L

E 4 untitled 1 - OpenOffice...

Gambar 3.1 Antarmuka Calc

Keterangan :
1. Menu : Menu sistem operasi, dalam gambar ini menggunakan sistem operasi
Ubuntu

2. Operasi File : Load, Save dan Save As.
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S T

10.

11.

12.

13.

14.

15.

16.

17.
18.

19.

Export as PDF : Untuk menjadikan dokumen menjadi file PDF.

Spellcheck : Untuk mengecek ejaan dengan fitur Check As You Type.

Cut, Copy, Paste : Fasilitas untuk menyalin objek.

Undo dan Redo : Tombol yang berguna ketika Anda melakukan kesalahan dan ingin
mengembalikan ke operasi sebelumnya.

Sort : Untuk mengurutkan teks atau serangkaian angka dari atas ke bawah atau
sebaliknya.

Navigasi : Tool LibreOffice.org yang paling umum, mencakup Zoom dan Help.
Text Formatting : Menu untuk memilih font dan style untuk teks yang telah dipilih.
Justification : Untuk mengatur justifikasi teks dan angka dalam beberapa pilihan.
Number Format : Format umum untuk angka, mata uang dan desimal.

Range Selection : Untuk memilih lokasi sel, baris atau kolom serta untuk mencari
seleksi sebelumnya.

Function Wizard : Panduan untuk membuat sebuah formula dengan sebuah
function.

Cell Content : Sel di lembar utama yang menunjukkan sejumlah nilai, namun area
ini akan menunjukkan function yang dimasukkan di dalam sel yang bisa diubah di
kotak ini.

Column : Kolom spreadsheet. Dimulai dari kolom A sampai dengan kolom IV.
Row : Baris spreadsheet. Ditunjukkan dengan angka. Ukuran dapat diperbesar
dengan cara men-drag garis batasnya.

Cell : Sel berisi angka atau teks yang dapat diatur menurut style tertentu.

Sheet Tab : Secara standar ada tiga sheet yang tersedia untuk setiap dokumen. Klik
kanan untuk menambah lembar baru atau untuk mengubah namanya.

Status Bar : Berisi keterangan mengenai ukuran tampilan, sum, serta average.

3.2. Mengaktifkan LibreOffice SpreadSheet

Untuk menjalankan aplikasi LibreOffice spreadsheet, anda bisa melakukannya dengan

meng-klik menu utama Activities kemudian pilih menu LibreOffice Calc. Kemudian

aplikasi libreoffice spreadsheet akan dijalankan oleh komputer, akan tampil jendela

antar muka LibreOffice.org Spreadsheet seperti yang terlihat pada gambar.
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Gambar 3.2 Lembar Kerja Calc

3.3. Mengetahui Cara Menyimpan File

Pada LibreOffice.org Spreadsheet banyak mendukung berbagai format dokumen
spreadsheet yang bisa anda gunakan, diantaranya format Microsoft Exel 2000 (.xls),
Data Interchange Format (.dif), dBASE (.dbf), .xml, dan lain sebagainya.

Untuk melakukan penyimpanan dokumen spreadsheet yang telah anda buat, ada 2 cara
yang bisa anda gunakan, yaitu:

1. Menggunakan Ikon SAVE pada Menu Bar.

2. Menggunakan menu Berkas -> Save.

Lebih detail mengunaan Ikon SAVE adalah sebagai berikut:

a. Dengan mengklik ikon EJSAVE pada MenuBar.

b. Kemudian akan muncul jendela dialog, seperti pada gambar dibawah ini.

Name: [Latihan\ ]

¥ Browse for other fFolders

« || @ indahsari || Documents| Create Folder
Places Name « Size Modified
Q, search [ Zuma1 10/23/2010
@ Recently Used i wine 10/27/2010
il indahsari [ sherly 11/16/2010
B Desktop i sakra 11/15/2010
1 File System [ presentasi seminar 11/15/2010
E3 15GB Files... il other 11/13/2010
2 20 GB Files & Modul 11/12/2010

T ~ [ materi pelatihan SPTB Boyolali 09/26/2010 ||~

ODF spreadsheet (.ods) -

» File type

Save with password

| cancel || save

Gambar 3.3 Kotak Dialog Save
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(a) Pada kolom “Name”: isikan nama berkas yang anda inginkan.

(b) Simpan ke dalam folder : ini tempat dimana berkas anda akan disimpan,
secara default opsi ini akan menunjuk ke dalam folder /home/documents,
tetapi anda bisa mengubahnya dengan mengklik opsi “Lihat folder lainnya”.

(c) Jenis Berkas: opsi ini bisa anda gunakan untuk memilih berkas yang telah
anda buat ingin disimpan dalam format apa.

c. Setelah semua opsi anda tentukan sesuai dengan keinginan anda, tekan “Simpan”
untuk menyimpan berkas anda.
Cara lain untuk penyimpan berkas spreadsheet melalui menu Berkas | Simpan (seperti

yang terlihat pada gambar), kemudian lakukan cara seperti yang telah disebutkan diatas.
EileY Edit View Insert Format Tools Data Window Help

e e vBARE-46 - @ki.é0 BeE |

Open... Ctrl+0

Recent Documents w <] A 4 A | R = o | | & E - i

Wizards

Close
Save OO s D | E ] F | G I H I I J I K I
!faveﬂs... Ctrl+Shift+S Niai1 Mgz | i3

Save All
Reload 85 85 85
Versions...

Export... :l

|
Export as PDF... }
\

Send

Properties...
Digital Signatures...
Templates

Preview in Web Browser

Page Preview
Print... Ctrl+P
Printer Settings...

Exit Ctrl+Q
w)()(v) (1 Sheet1 4Sheel) Zoheeld £ 7 10« A |
Sheet 1/3 [Default I [sTo][E [ Sum=0 [[e——e—— ®][100%]

Gambar 3.4 Menu Save

3.4. Mengetahui Cara Membuka File

Ada beberapa cara yang bisa anda lakukan untuk membuka berkas spreadsheet, berikut

ini cara untuk membuka berkas spreadsheet:

1. Buka aplikasi LibreOffice.org Spreadsheet dari menu utama Activities kemudian
pilih menu LibreOffice Calc

2.  Kemudian klik menu File | Open, atau anda bisa menggunakan shortcut papan

ketik dengan menekan tombol “CTRL+O”.
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B ) B 1:53PM @) indahsari (O
Data Window Help

a4
ERTE AR A6 @IS E |
A4AEEEEFId«R2EEL-E- i

ctri+s [ D ] E | F | G I H | | J I K | —r=
ctrl+shift+s Milai 1 MNilai 2 Nilai 3
95 95| 75
%0 90 80
85 85 85
80 80 20

Templates

Web Browser

Page Preview
Print... Ctrl+P
Printer Settings...

Cctrl+Q
| i+ i i : - 1
| [sheet1/3 [Default I |[so] M Sum=0 [@——e — @|[100%]
Gambar 3.5 Menu Open

3. Selain itu anda juga bisa menggunakan ikon Open @ pada menubar.
4. Kemudian akan muncul kotak dialog Open (seperti pada gambar), pilih berkas yang

spreadsheet yang ingin anda buka.

|f\ | 1H home.H indahH.Documents.H Prioritas Kerja.” Gambar Modul.H. Pengenalan open Office || cALc|

Places Name - Size Modified
Qsearc
& Recently Used M lembar kerja baru.png 65.6KB | 13:37

£ indahsari M kotak dialog save.png B7.8KB 13:44

B8 Desktop

[ File system

1 15GBFiles...

1 20GBFiles...

I[© Documents

i Music

[® Pictures

i@ videos

&3 Downloads

Add Remove AllFiles x

P File type
Version:

["] Read-only

[ cancel |

Gambar 3.6 Kotak Dialog Open
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3.5. Mengetahui Cara Menjumlah Lajur
Untuk menjumlah jalur pada spreadsheet, ikuti cara-cara berikut:
1. Buat data numerik/angka yang akan dihitung, bisa per-kolom ataupun per-baris.
2. Kemudian di sel lain ketikan peritah berikut:
=SUM (bilangan1,bilangan2,...)
dimana bilanganl adalah letak dimana sebuah angka/data numerik pertama diletakan

(seperti pada gambar).

] = ) 2:04PM @ indahsari b
File Edit View Insert Format Tools Data Window Help

O LEAI|HE =MV LR - @@ BB .

) (aa T A4AEEEEH b waEER-E- i

UM v feo ¥ f [mumiczcs) |
A B8 | E | E G H | | J | K A
No. Nama ilai 1 Nilai 2 Nilai 3

Sakra 7 5 95
=5Um(C2:CH!

|m|mum‘m‘h‘u|m|—
=
c
=
o
g

=1

r~

w

=

"

=

=)

@

o

~
)

~

r~
o
4

o) ()1 Sheet 1 {SREeT? JSheets {7 I d

Gambar 3.6 Menghitung Lajur

3. Kemudian tekan tombol “ENTER” pada papan ketik anda.

3.6. Mengetahui Cara Mencetak Dokumen atau Berkas

Pencetakan berkas di LibreOffice.org Spreadsheet cukup mudah, berikut ini cara
melakukan pencetakan dokumen:

a. Buka berkas spreadsheet yang akan anda cetak

b. Klik menu File | Print, anda juga bisa menggunakan shortcut papan ketik dengan

menekan tombol CTRL+P.
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gl =P o) 2:09PM @ indahsari (O

Filed Edit View Insert Format Tools Data Window Help
»

o REEETRCAE TIPSR YRR TSR N N A
Recent Documents o T+ & 4 .é| | b % %2 ﬁ%‘|E|'E' i
Wizards
Close = | “
Save Ctri+s [ D | E | F | G | H | 1 | 3 | K s
Save As...  Ctrl+Shift+S Nilai 1 Milal 2 HNilai 3
s All 95 95 75
90) 90 80|
85 85 85
80 80 90 |
75 75 95 |
425 |
Properties... i
Digital Signatures...
Templates 3
Web Browser
Eﬂn[er Settings...
Ctrl+Q
. (Sheet? aheets 2.4 I ; >I'
= .= ==« 1T =1 1 = = 1= = =11
Gambar 3.7 Menu Print

c. Kemudian akan muncul kotak dialog Print, yang berfungsi untuk melakukan

pengaturan halaman yang akan dicetak.

Printer
Hame |De slﬂ:et—bZSUU:Ee ries : | | Frope rties... |
Status Default printer
Type CUPS:Deskjet-D2500-series
Location indahsari-laptop
Commenkt HP Deskjet D2500 series
Print to file
Print Copies
All sheets Mumber of copies 1| =

@ Selected sheets
Selected cells Lﬂlﬂﬂ LIIEIEI B collate
Print range
@ All pages
1 Pages

| Options... |_ OK _| | Cance l- | | Help

Gambar 3.8 Kotak Dialog Print

Ada beberapa opsi dalam gambar kotak dialog Cetak diatas, diantaranya:

a) Pencetak : opsi ini adalah pengaturan mesin pencetak anda, jika anda mengklik
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tombol Properti, akan muncul kotak dialog pengaturan Kertas yang akan
digunakan, dan pengaturan perangkat mesin pencetak lainnya.
b) Cetak : opsi ini digunakan untuk mengatur pencetakan lembar kerja anda, ada 3 sub
opsi dari opsi Cetak ini:
(a) Semua Lembar: jika anda memilih opsi ini maka mesin pencetak akan mencetak
semua sheet yang ada pada berkas spreadsheet anda.
(b) Lembar Terpilih: jika opsi ini dipilih, mesin pencetak hanya akan mencetak
lembar kerja pada sheet yang aktif.
(c) Sel Terpilih: opsi ini digunakan jika anda hanya ingin mencetak pada sel yang
anda seleksi/pilih.
c) Jangkauan cetak : opsi ini digunakan untuk seberapa banyak halaman yang
harus dicetak oleh mesin pencetak. Ada 2 sub opsi yang bisa anda gunakan:

(a) Semua halaman: jika opsi ini dipilih mesin pencetak akan secara otomatis
mencetak semua halaman pada berkas spreadsheet anda.

(b) Halaman: anda juga bisa menentukan secara manual seberapa banyak
halaman yang harus dicetak oleh mesin pencetak, dengan menggunakan opsi
ini.

d) Rangkap : opsi ini digunakan untuk apabila anda ingin mencetak beberapa kali
cetakan pada berkas spreadsheet.

d. Atau anda juga bisa menekan ikon “Cetak Langsung” pada menu bar. Jika anda

menggunakan cara ini, dokumen spreadsheet anda akan secara langsung dicetak tanpa

anda melakukan pengaturan-pengaturan yang diperlukan saat pencetakan.

3.7. Menambah dan Menghapus Kolom atau Baris

3.7.1. Menambah Kolom atau Baris

Untuk Menambah kolom atau baris dengan cara :

1. Klik menu Insert.

2. Pilih Columns atau Rows.

3. Atau bisa dengan menggunakan menu melayang dengan meng-klik kanan pada
mouse.

4. Pilih Insert Columns atau Insert Rows.
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InSerEl Formak Tools INSerEl Format
FPage Break FPage Break
Cell CErl++

Link to External Data...

Special aracker...
Formaktkting Mark

Hyperlink
Function._. = d Funckt Cerl+F2
Funcktion Liskt Funckion Liskt

MNames

[e]=]]
Chark...
Floakting Frame

Floating Frame

Gambar 3.9 Menu Insert Columns atau Insert Rows

Format Cells... Format Cells...

Column width... Row Height...
Optimal Column Width... Optimal Row Height...
" Insert Rows
Delete Rows
Delete Contents...

Hide
Show

Cut
Copy

Paste

Gambar 3.10 Klik Kanan Insert Colums atau Klik Kanan Insert Rows

3.7.2. Menghapus Kolom atau Baris

Untuk menghapus kolom atau baris dengan cara :

1. Klik kanan untuk menampilkan menu melayang pada kolom atau baris lembar
kerja.

2. Pilih Delete Columns atau Rows.

L] o
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Format Cells...

Column Width...
Optimal Column width...

Format Cells...

Row Height...

Optimal Row Height...

Insert Rows
| Delete Rows _
Delete Conktentks... 3

Insert Columns
Delete Columns

Delete Contents...
Hide
Show
Cut
Copy
Paste

Gambar 3.11 Klik Kanan Delete Columns atau Delete Rows

3.8. Formula

Formula adalah operasi matematika untuk mendapatkan hasil dari perhitungan data pada

range sel data dengan operator matematika. Rumus formula dioperasikan dengan

diawali tanda sama dengan (=).

Membuat formula :

1. Klik pada sel dimana hasil dari formula akan ditampilkan.

2. Ketik tanda sama dengan (=).

3. Contoh : Formula untuk menampilkan hasil penjumlahan sel A1 dan A2, formula
yang dibuat pada sel : =A1+A2

4. Kemudian Enter.

Operator Aritmatika
Operator Nama Contoh
+ (Plus) Addition 3+5
- (Minus) Subtraction 3-1
* (Asterisk) Multliplication 3*3
/ (Slash) Division 12/3
% (Percent) Percent 30.00%
A (Caret) Exonentiation VAV
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3.9. Fungsi Vlookup dan Hlookup

3.9.1. Fungsi Vlookup

Fungsi Vlookup digunakan untuk membaca tabel data yang disusun secara tegak lurus

(vertikal). Bentuk umum dari fungsi Vlookup adalah :

=Vlookup(Sel kunci, Range Tabel, Offset Kolom)

Sel Kunci adalah kolom yang menjadi kunci dalam pembacaan tabel data. Range tabel

adalah daerah yang disorot (range) pada tabel pembanding. Offset kolom adalah kolom
yang akan dibaca pada tabel data.

Seperti pada gambar dibawah adalah contoh dari tabel penggunaan rumus Vlookup :

s Tvl i B = [-VzookurmssesssFss?
A | B c D | E | F |
1 DAFTAR NAMA SISWA
2 (Berprestasi)
3
4 Tabel pembanding
5 INama Kode Jurusan Kode Jurusan
6 Andika SK Sekretaris AK Akuntansi
7 |Surahman  |AK SK Sekretaris
8 |Febriana MB MB Manajemen Bishis
9 |Verawati SK
10 | Jenny MB
11 |[Kresna AK
12 |Nana AK
13 Berliana MB
14 |Gadung SK
15

Gambar 3.12 Tabel Vlookup

3.9.2. Rumus Hlookup

Fungsi Hlookup digunakan untuk membaca tabel data yang disusun secara mendatar
(horizontal). Adapun bentuk umum Hlookup adalah :

=Hlookup(Sel Kunci, Range Table, Offset Baris). Offset baris adalah baris yang akan
dibaca pada tabel data.
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Seperti pada gambar dibawah adalah contoh dari tabel penggunaan rumus Hlookup :

[cs [w ] fx ¥ = [-HLOOKUPBE SB$17-8DS18.2)
A [ B c D [

z DAFTAR NAMA SISWA

2 (Berprestasi)

4

£

5 [Nama Kode Jurusan

& Andika SK Sekretaris

7 |Surahman A

& |Febriana MB

9 Nerawati SK

10 |Jenny MB

17 |Kresna A

12 |Nana A

12 |Berliana MB

14 |Gadung SK

15

16 |Tabel pembanding

17 |Kode iy .4 SK MB

78 [Jurusan Akuntansi Sekretaris Manajemen Bisnis
19

Gambar 3.13 Tabel Hlookup

3.10. Format Angka

Untuk memformat angka pada LibreOffice.org dengan cara :
1. Sorot angka yang akan diformat.

2. Pilih Format Cells.

3. Maka akan muncul kotak dialog Cells.

© Format Cells

Numbers | Font Font EFfects Alignment Borders| Background | Cell Protection

Category Formakt Language
All < - |IDR Rp Indonesian = L =
HSL'_I =) r;— I:ijeerﬁ ned | I 'fR'EI_:Edj = e
| (Eiiieo i
P i T g
Scientific ~|  -1234,00IDR - | RpS5,00
Options

Decimal places 2 = ¥ Megative numbers red

Leading zerces 1 = B Thousands separator
Format code
[$Rp-421]#.#20,00;[REDI{[$Rp-42 1]3.#0,00)
User-defined

[TJ |  cancel Help Reset

Gambar 3.14 Kotak Dialog Format Cells

4. Pilih kategori angka sesuai kebutuhan.Gambar 3.14 Kotak Dialog Cells

o -
cailrgeurtiin
%——"
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3.11. Membuat Grafik

Dalam membuat dokumen spreadsheet, kadang kala Grafik atau Chart sangatlah
bermanfaat untuk menerjemahkan angka-angka menjadi sesuatu yang visual dan mudah
dimengerti. Grafik juga dapat mudah menarik perhatian pembacanya.

3.11.1. Siapkan Data

Sebelum memulai membuat grafik, persiapkan data yang akan Anda buat grafiknya
terlebih dahulu. Ada baiknya data tersebut terangkum dalam satu kolom atau baris dari
pada tersebar berserakan. Anda juga perlu untuk mengurutkan data tersebut sehingga
nantinya hasil grafik juga akan terlihat lebih rapi.

3.11.2. Memberi Label

Beri label masing-masing data yang ada di kolom spreadsheet. Chart wizard dapat
mengambil label dari kolom dan baris yang Anda buat. Pastikan saat menyeleksi baris
dan kolom, bagian label tersebut ikut terpilih. Jika label tidak ikut terpilih, nanti grafik

tidak akan memunculkannya.
File Edit View Insert Format Toc
e R NSNS TR - 4
bla o [)|B|/ U

B3:C3 v fx Z = [eulan
| I c D E.

ols Data Window Help
A O E S ] @
8% T a¥le==I0-2-A -5

I [m
i €

o
I

H 1 | J | K L ™ N o

>
-
o]

A |-

]
T
&
H
8
B
8

o
z
I3
&

o
w
2
2

o
>

§ST8 ¢
0
8
k4

©
<
"
8
&

10 Juli 241
11 Agustus 241
12 September 273

13 Oktober 367
14 November 345
15 Desember 298
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

» \Sheet1 /Sheet? 7 Sheets ———

DG |
Sheet 1,3 [ Default s [= [ | Sum=0 [@——o—— & [100%

Gambar 3.15 Memberi Label

3.11.3. Memilih Range

Pilih range (area) yang akan digunakan untuk grafik dengan cara meng-klik dan
mendrag sel sehingga terseleksi semua. Anda juga bisa mengedit range dengan cara
mengetik nilai pada text field. Untuk memilih range, Anda ketik nama atau

menggunakan menu drop down.
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File Edit View |nsert Format Tools Data Window Help
B EH e e K @My e E Y@,
bom  m B/ U ====t 4% %8s 0247

]
I &

B3:C15 <] fx & = [euan
[ A am

i c | D E H ] | 1 | K | L | ™M

-
]

[Bulan ] Penjualan
anuart

[Febaruari 2886|
Maret 345|
il 267]
IMei 300|

il 241
|lAgustus 241
'September 273
Oktcber 367|
November 345|
[Desember 2

i<[+|» [ \Sheet1 (Sheets JSheets <E

Gambar 3.16 Memilih Range

3.11.4. Chart Tool

) ERS |
Sheet 1/3 | Default s [BE [ | Sum=3476 [@——%—— @ [100%

Dengan posisi range yang sudah terpilih, klik menu Insert >> Chart atau dari Chart

tool yang ada di toolbar. Selanjutnya akan terbuka kotak dialog Chart Wizard. Sebuah

grafik akan muncul di belakang kotak dialog. Tidak perlu khawatir akan ukuran grafik

tersebut jika dirasa terlalu kecil bagi Anda. Anda bisa memperbesar atau memindahkan

ke lokasi yang lebih luas.
3.10.5. Tipe Grafik

Anda bisa memilih tipe grafik untuk menunjukkan data dalam spreadsheet. Jika data

berupa penjualan barang dari sebuah toko misalnya, maka tipe bagan yang cocok adalah

pie (grafik kue). Data berupa nilai penjualan per tahun mungkin lebih tepat

menggunakan grafik bar, sementara pergerakan profit di pasar modal lebih cocok

menggunakan bagan Candlestick. Setelah itu tekan tombol Next.
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<% Applications Places System Q%Q!ajmau % [ZRSL TR | “-- FriFeb 5, 5:14PM ® ponyo
— grafik.ods - OpenoOffice.org Calc &8 &
File Edit View Insert Format Tools Window Help
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1= Ctcber 367) Steps Choose a chart type
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Gambar 3.17 Memilih Tipe Grafik

3.11.6. Konfirmasi

'T
use: I — T 20

Bagian kedua di dalam Chart Wizard adalah menanyakan data range yang akan

digunakan dalam grafik. Apabila Anda telah menentukan data tersebut, seharusnya

nilainya telah muncul di data range. Kini Anda hanya perlu mencontreng kotak First

raw as label dan First column as label apabila Anda ingin menyertakan label pada

grafik.

Steps Choose a data range
Dat
1.Chart Type LASHElD

[sSheet1.5B$3:5C515

2.Data Range

2 Data series in rows
3.Data Series ¢ -

@ Data series in columns
4. Chart Elements

First row as label

First column as label

Finish

Help

[ << Back H Next == l l

l [ Cancel

Gambar 3.18 Data Range
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3.11.7. Judul Grafik

Langkah berikutnya adalah memberikan judul grafik, sub judul dan melabeli sumbu X

ataupun sumbu Y dari grafik. Pada sesi ini juga Anda diminta menentukan letak dari

legenda grafik.

Steps

1.Chart Type
2.Data Range

3.Data Series

4. Chart Elements

Choose titles, legend, and grid settings

Title |Grafik Penjual | | [ Display legend
Subfitle (Tahun 2009 | | Oleft
@ Right
X axis {Bulan ] 0 Top
Y axis [jumlah ] ) Bottom
Z axis
Display grids
Y axis [ Z axis

Next >=> Einish l [ Cancel

Gambar 3.19 Memberi Judul Grafik

3.11.8. Menerapkan Grafik

Setelah Anda atur semua kebutuhan grafik tersebut, Anda tinggal meng-klik tombol

Finish untuk menerapkan hasil grafik ke lembar kerja.
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Gambar 3.20 Gambar Grafik
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3.10.9. Mengubah Grafik
Grafik tersebut seperti halnya objek lain. Anda bisa melakukan klik kanan pada grafik

tersebut. Lalu akan muncul menu text dan pilih perintah yang ada.

Eile Edit View Insert Format Tools Data Window Help

B EHs2aéERYs XERgI®- -

@b 8 @ e ] @

. ~ " B A ~ ~ = -
b -0 oo o) [MMeisck 3] & [cor o]dewes 3] @ o LT8T = IFd- g
~E =]
A T s D E [ f [ o H T Tk [ w M N o =
1
2
3 Bulan Penjualan [{] a L a
r \Januari 245 Grafik Penjual
5 Febarari 286 Tahun 2009
6 Waret 345 400
7 April 267 350
) el 300 300
) Juni 268 .
10 Jul 241
5 20 rpsaian
11 Agustus 241 s @ Pengian &
12 September 273 3 e
13 Oktober 367 -
12 November 345
15 Desember 208 RN ALYy
s | —1 Il R MAWAal 7 Position and Size...
18 Bulan = =
18 a a Activate OLE object
19 Activate OLE object outplace
20
S Description...
22 Name...
23
e Arrange
= Alignment
26 Anchor
27
28 Group
29 54 Cut Py
50 B T -
> \Sheet1 {Shestz {Sheets = <
[Default Edit H314x2.75 [6——e—— & [100%

Gambar 3.21 Mengubah Grafik

3.11.10. Memberi Warna Latar
Untuk memberi warna latar dari sebuah grafik, klik kanan grafik tersebut dan pilih Edit.
Setelah itu klik kanan lagi dan pilih Object Properties.

Klik tab Area dan pilih warna untuk dijadikan sebagai warna latar grafik Anda.
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8

Eile Edit View Insert Format Tools Window
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Gambar 3.22 Memberi warna Background
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3.11.11. Menambahkan Gradasi

Klik kanan untuk memilih Object Properties dan klik tab Transparency. Di sini Anda

bisa memilih model-model transparency. Pilih Gradient dan tentukan tipe gradasinya

serta atur persentasenya.

<% Applications Places System Q’Mw !E[a‘_j@\@)\g/ % B @ vl “—- FriFeb 5, 6:32PM ® ponyo
= grafik.ods - Openoffice.org Calc o000
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3.11.12. Efek 3D

Gambar 3.23 Menambah Gradasi

Agar grafik terlihat lebih menarik, Anda bisa memberikan efek 3 dimensi. Klik kanan

grafik dan pilih Chart Type. Beri tanda centang kotak 3D Look dan klik OK.

il Column

B Bar

& Pie

I Area

|2 Line

[#% XY (Scatter)

[&] Net

iz Stock

il Column and Line

it)| (=8

3D LD% simple ¢ |
Shape

Cylinder
Cone
Pyramid

= -
[ —TT 1 g
=k

I

)

Cancel

Help

Gambar 3.24 Memberi Efek 3D
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3.11.13. Mengubah Elemen Grafik
Anda bisa meng-klik ganda pada objek-objek di dalam grafik untuk mengatur
propertinya. Setelah di klik ganda, klik kanan dan pilih Object Properties. Anda bisa

mengatur jenis huruf, warna, serta ukuran.

<% Applications Places system @52 &S] | X ES« - FriFeb 5, 6:41PM ® ponyo
=) grafik.ods - OpenOffice.org Calc o000

& = 2L B - =]
EFH2 a0 & |EEAW|
A | B [ ¢ [ o [ E ] F | G | n ] 1 —2 s M N Ol &

i =

3

3 Bulan Penjualan i o Tt

4 Januari 245 %;,/' P 5}%

3 Febaruari 266 Tahun 2009

6 Maret 345

7 = o [TTT 11

8 Mei 300 350 }

5 « LLL L] |

10 Juli 241 0 [ =) Title ‘\ e

11 Agustus 241 sl - 5 - .

12 September 273 ‘ |Borders | Area | Transparency | Characters |Font Effects | Alignment |

= e = Font color Qverlining Over
i | Desember 208 s (Without) 2 tic 2

16 o ) |

7 Strikethrough

18 (Without) 2

19 ——

20 Relief Underlining

2 [twithout) B [(without) z

23 0 outline w

24

25 [ shadow

26

27

28

29

30

31 Grafik Penjual

32

33 .
[34] [ ok ][ cancel |[ melp || meset |
[ 35 | v
W[« [> [hSheet1 (Shestz [Sheats /|| <E 5] ol
[ Main Title selected [+
@ | i& ografik.ods - OpenOffice... vsA: [ — IR (_j

Gambar 3.25 Mengubah Elemen Grafik

3.12. Fungsi Terbilang

Fungsi terbilang berfungsi untuk menguraikan sejumlah nilai dari perhitungan
Langkah-langkah untuk menggunakan fungsi terbilang adalah sebagai berikut :

1. Jalankan LibreOffice.org Spreadsheet.

2. Pilih Tools

3. Pilih Macro

4. Organize maMacro

5. Pilih OpenOffice.org basic

.

& -
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Tools Data Window Help
Spelling... F7
Language »
Detective b
Goal Seek...

Solver...

Scenarios...

Share Document...

Merge Document...

Protect Document »

Cell Contents »

Gallery

Media Player

Macros - Record Macro

Extension Manager... Run Macro...

XML Filter Settings... Organize Macros y ~ Op{yOffice.org Basic...

AutoCorrect Options... Digital Signature. JavaScript...
1 " BeanShell ..

L i Organize Dialogs... 5

Options... Python...

Gambar 3.26 Menu Tools — Macros

6. Pada kotak dialog openoffice.org basic pilih macro dari My Macro > Standard
7. Klik New
8. Maka akan muncul halaman editor, Isi halaman editor tersebut dengan kode dibawah

ini :

- .h 59
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= My Macros & Dialogs.Standard - OpenOffice.org Basic [ — = =]

File Edit View Tools Window Help

-ty i e sars 2 3 (5) ) TP P € B e ) EJH LS

. [rreT—— .

Function Kekata(Bilangan as double) As String

Dim angka as variant

angka = Array("","satu","dua","tiga", "empat”,"lima", "enam",
"tujuh","delapan”,"sembilan”,"sepuluh"”, "sebelas")

Bilangan = abs(Fix(Bilangan))

TIf Bilangan<12 Then

Kekata = " " & angka(Bilangan)

Elseif Bilangan<2@ Then

Kekata = Kekata(Bilangan - 18) & " belas"

Elseif Bilangan<108 Then

Kekata = Kekata(Fix(Bilangan/10)) & " puluh” & Kekata(Bilangan mod 10)
Elseif Bilangan<200 Then

Kekata = " seratus” & Kekata(Eilangan mod 188)

Elseif Bllangam<lE)E)B Thel

Kekata = Kekata(le(ElLangam/mB)) & " ratus" & Kekata(Bilangan mod 100)
Elseif Bilangan<=2000 Then

Kekata = " seribu" & Kekata(Bilangan mod 1080)

Elseif Bilangan<leeeee® Then

Kekata = Kekata(Fix(Bilangan/1008)) & " ribu" & Kekata(Bilangan mod 1800)
Elseif Bilangan<l000800088 Then

Kekata = Kekata(Fix(Bilangan/1008600)) & " juta"

Kekata(Bilangan- (Fix(Bilangan/10680088)* wﬂt—)asﬂ))

Elseif Bllangam<lE)E)BBE)E)BBBE)BB Then

Watch| | Calls:
[Variable [Value [Tope ]
odutel <] =]
My Macros & Dialogs.Standard. Modulel OVER |Ln61,Col 1 INSRT

Gambar 3.27 Module Macros

Function Kekata(Bilangan as double) As String

Dim angka as variant

mmn mon mn

angka = Array("","satu","dua","tiga","empat","lima","enam",

mn mn

"tujuh","delapan”,"sembilan","sepuluh”,"sebelas")

Bilangan = abs(Fix(Bilangan))

If Bilangan<12 Then

Kekata =" " & angka(Bilangan)

Elseif Bilangan<20 Then

Kekata = Kekata(Bilangan - 10) & " belas"

Elseif Bilangan<100 Then

Kekata = Kekata(Fix(Bilangan/10)) & " puluh" & Kekata(Bilangan mod 10)
Elseif Bilangan<200 Then

Kekata = " seratus" & Kekata(Bilangan mod 100)

Elseif Bilangan<1000 Then

Kekata = Kekata(Fix(Bilangan/100)) & " ratus" & Kekata(Bilangan mod 100)
Elseif Bilangan<2000 Then

Kekata = " seribu" & Kekata(Bilangan mod 1000)

Elseif Bilangan<1000000 Then
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Kekata = Kekata(Fix(Bilangan/1000)) & " ribu" & Kekata(Bilangan mod 1000)
Elseif Bilangan<1000000000 Then

Kekata = Kekata(Fix(Bilangan/1000000)) & " juta" &_
Kekata(Bilangan- (Fix(Bilangan/1000000)*1000000))

Elseif Bilangan<1000000000000 Then

Kekata = Kekata(Fix(Bilangan/1000000000)) & " milyar" &_
Kekata(Bilangan- (Fix(Bilangan/1000000000)*1000000000))

Elseif Bilangan<1000000000000000 Then

Kekata = Kekata(Fix(Bilangan/1000000000000)) & " trilyun" &_
Kekata(Bilangan- (Fix(Bilangan/1000000000000)*1000000000000))
Else

Kekata = "Error! Input Tidak Dapat Diproses."

EndIf

End Function

Function Terbilang(Bilangan as Double, Optional Style as Integer) as String
Dim temp as String

If Bilangan<0 Then

temp = "Minus " & trim(kekata(Bilangan))

Else

temp = trim(kekata(Bilangan))

EndIf

If Style=1 Then

Terbilang = ucase(temp)

Elself Style=2 Then

Terbilang = lcase(temp)

Elself Style=3 Then

kata = split(temp)

1 = LBound(kata)

u = UBound(kata)

For i=ltou

kata(i) = ucase(mid(kata(i),1,1)) & mid(kata(i),2)
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Next i

Terbilang = join(kata())
Else

Terbilang = ucase(mid(temp,1,1)) & mid(temp,2)
EndIf

End Function

62

. Kemudian cobalah dengan memasukkan angka pada cell A1 kemudian masukkan

rumus pada cell lainnya dengan cara :

=terbilang(cell;style)

cell adalah kolom yang berisi bilangan yang akan diterjemahkan.

style adalah nilai integer yang sifatnya optional untuk mengatur output cara
penulisan huruf besar atau kecilnya, dan jika tidak disertakan akan tampil huruf
besar pada awal kalimat saja.

Nilai Style dapat dilihat sebagai berikut:

1 = Ditulis huruf kapital (Uppercase) semua

2 = Ditulis huruf kecil semua

3 = Huruf kapital hanya pada awal kata saja

Lainnya = Huruf besar pada awal kalimat saja

Misalkan cell G1 berisi bilangan 375000, dan kita akan menuliskannya di cell H1,
maka:

= terbilang(G1) menghasilkan: Tiga ratus tujuh puluh lima ribu.

= terbilang(G1;1) menghasilkan: TIGA RATUS TUJUH PULUH LIMA RIBU

= terbilang(G1;2) menghasilkan: tiga ratus tujuh puluh lima ribu

= terbilang(G1;3) menghasilkan: Tiga Ratus Tujuh Puluh Lima Ribu

Dan untuk menambahkan rupiah di akhir kalimat, cukup melakukan trik berikut:
= terbilang(G1;3) & " Rupiah" menghasilkan: Tiga Ratus Tujuh Puluh Lima Ribu
Rupiah
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A

Rp23.000.000.000
Dua puluh tiga milyar
DUA PULUH TIGA MILYAR
dua puluh tiga milyar

Dua Puluh Tiga Milyar
Dua Puluh Tiga Miliar Ruéiah ‘

Gambar 3.28 Hasil Rumus Terbilang
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BAB IV
LIBREOFFICE.org IMPRESS

LibreOffice.org impress adalah modul yang disediakan untuk keperluan membuat
dokumentasi presentasi. Fitur dan fungsi yang ada pada impress kompatibel dengan
microsoft power point. LibreOffice.org impress dilengkapi dengan fitur-fitur yang

sangat baik dan menarik untuk presentasi.

4.1. Membuat presentasi baru

Setelah membuka impress, kotak dialog Presentation Wizard pada gambar 4.1 dibawah

ini akan muncul. Jika tidak, klik File > Wizard > Presentation.

© Presentation Wizard

Edit View Insert Format Tools Slide Show

'Ztrl+:::w’ ; | Lig-“ | m@'
5

Documents

Type
® Empty presentation

From template

Open existing presentation

Il Preview

Do not show this wizard again

% % == ia[k

Gambar 4.1 wizard libreoffice impress

® Dibawah Type, pilih salah satu dari pilihan-pilihan berikut:

1. Empty Presentation membuat presentasi dari awal.

2. From Template menggunakan sebuah desain template yang telah dibuat sebagai
dasar bagi sebuah presentasi.

3. Open Existing Presentation melanjutkan pekerjaan pada presentasi yang telah

dibuat sebelumnya.

64 n:ﬁ‘:a.rﬁh
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® Klik Next

Kotak dialog Presentation Wizard akan muncul:
1. Di bawah select a slide desaign, pilih desain, atau biarkan kosong, pilih <Original>

2. Pada Select an output medium, pilih bagaimana presentasi akan digunakan. Paling

sering, presentasi dibuat untuk layar.
3. Kilik Next.

® Presentation Wizard

Select a slide design

|Presentation Backg@unds QJ

Blue and Grey

Black a hite
Technical Polygon | |
Red Noise Shapes

L R I & T e

Select an output medium

Original ® Screen
Overhead sheet Slide ;

s Preview
Paper

| Melp | Cancel || <<Back || Next>> ||  Create |

Gambar 4.2 presentation wizard

4.2. Memodifikasi slide

Bila slide yang ada akan dihapus, tempatkan mouse di atas slide yang akan dihapus

(pada bagian kiri layar). Kemudian tekan tombol Delete. Sedangkan untuk mengganti

nama slide:

® Tempatkan mouse pada slide yang akan diganti namanya (pada bagian kiri layar)
dan klik kanan, pilih Rename Slide.

® Pada kotak dialog Rename Slide, ketik nama baru slide pada field Name dan tekan
tombol OK.

1 [ 65
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£ Rename Slide

MName

. — .
|slide 1]

Gambar 4.3 rename slide
Untuk menyusun ulang posisi urutan slide, pada area penyuntingan dokumen presentasi

pindahkan ke tab slide sorter. Kemudian klik dan drag setiap slide yang dipindahkan ke
urutan yang diinginkan.

Normal Outline Notes Handout Slide Sorter

1 Pengenalan Linux dan
BlankOn Linux 5.0 Nanggar

2 3

Pengantar

Apa ftu Linux 7

Apa itu GNU ?
« St gt

slide 1 Slide 2 slide 3 Slide 4

Macam-macam 05
- Miczosck Windoms
- Machimch
- Usix

slide 5

H ”_”—HslidelJ'SHorans;i
Gambar 4.4 slide sorter

4.3. Menambahkan gambar

Ada bermacam-macam tipe gambar yang dapat ditempatkan dalam presentasi. Meng-

import file gambar atau memilih gambar-gambar yang telah dirancang dari impress
galeri.

® Meng-import gambar dari file
1. Pilih Insert > Picture > From File untuk mengakses jendela Insert Graphics.

2. Sorot dengan mouse file gambar yang akan diimport.

3. Klik open untuk menyisipkan ke dalam slide.

h
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© @@ pengenalan linux_dan blankon.odp - Of
) ) ) |#| < o sakrasemangat | Gambar |
File Edit V - Format Tools Slide Show Wir —
Location: | |
h sl REC_ |REC
Duplicate Slide | fhoces eme L 2y Mol
o T Q search i Foto 30/04/10
DRecently Used = 11jpg 27,9KB  30/04/10
@ sakrasemangat | ™ browserl.png 300,2 KB 30/04/10
@ Desktop “ browser2.png 271,8KB 30/04/10
Page N umber... i EXFile System =+ browser3.png 401,5 KB 30/04/10
and Time.. 1 [ 20 GB Filesyst... 8 desktop.png 509,8 KB 30/04/10
200 GB Filesy... | [l desktop (salinan) png 290,4 KB 30/04/10
/100 GB Filesy... | empathy.png 765KB  30/04/10
Comment 18 GB Filesyst... = evolution.png 155,1 KB 30/04/10
I3 Dokumen T F-spot.png 268,4 KB 30/04/10
: il = impress_Lpng 197,5KB Kamis
Formatting Mark ;!:;’Ear T e e
i@ Video @ officel.png N 6794 KB 30/04/10
£ Unduhan " office2.png 69,3KB  30/04/10
1 — office3.png 755KB  30/04/10
3 pitipi.png 72,5KB  30/04/10
== rhythmbox.png 1285 KB 30/04/10
| Add | | <All formats> i
+ File type
Preview
Chart... Link
Floating Frame e [ ——
File...

Gambar 4.5 mengimport gambar

® Meng-import gambar dari galeri

Pada bagian ini akan dibahas bagaimana cara menyisipkan gambar dari galeri. Galeri

adalah satu set gambar-gambar yang dirancang untuk membantu para pengguna untuk

memilih grafik-grafik bagi presentasi.

1. Pilih Tools > Galerry

2. Obyek-obyek gambar berada di dalam gallery dan galerry theme box. Obyek-obyek
gallery dapat diubah di dalam galerry theme box.

3. Klik dan drag objek yang dikehendaki dari galerry ke dalam slide yang sesuai.

4. Ketika selesai, klik Tools > Galerry kembali untuk menyembunyikan galerry

tersebut.

| New Theme... J E\Bm':—_ Backgrounds - ice-light (/usr/lib/openoffice/basis3.2/share/gallery/wv

® Backgrounds
® Bullets

® Homepage
® My Theme
® Rulers

® Sounds

Gambar 4.6 toolbox gallery
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4.4. Mengubah latar belakang slide dan area

Untuk mengubah latar belakang slide:

5. Pilih Format > Page. Kotak dialog Page Setup akan muncul dengan dua tab, Page
dan Background.

6. Klik tab Background, dan buat perubahan sesuai dengan yang dikehendaki.

7. Klik OK, sebuah kotak dialog akan muncul menanyakan “Background settings for

all pages?” klik Yes jika anda menginginkan latar belakang tersebut untuk muncul pada

semua slide, atau No jika anda menginginkan latar belakang tersebut hanya muncul

pada slide yang dipilih.

Page Background

Fill Increments

|Gradient = & Automatic

™™ Gradient 1 N
Bl Gradient 2

[l Gradient 3

[ ] Gradient 4

Bl Gradient 5

™ Gradient 6

I Linear bluejwhite
Il Radial green/black
[ Rectangular red/white
[ square yellow/jwhite
I Linear magenta/green
[ Linear vellow/brown

—

Gambar 4.7 page setup

[ OK JL Cancel 1 Help 1 Reset |

® Mengubah latar belakang area

Untuk mengubah latar belakang dari sebuah area, misalnya sebuah text atau sebuah

bentuk:

1. Pilih area yang dikehendaki. Ketika dipilih, dia akan dikelilingi oleh sebuah kotak
berwarna abu-abu berisi pengubah ukuran berwarna hijau.

2. Pilih Format > Area. Kotak dialog area akan muncul, pilih setting yang
dikehendaki.
3. Kemudian klik OK.
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Area Shadow Transparency Colors Gradients Hatching Bitmaps

Fill

[Color =
[ JBlue 8 A
[ Turquoise 1

[ Turquoise 2

I Turquoise 3

[ Turquoise 4

I Turquoise 5

I Turquoise 6 h
Il Turquoise 7

Il Turquoise 8

Bl Green 1

B Green 2

I Green 3 r

OK || Cancel | Help | Reset |

Gambar 4.8 format area

4.5. Transisi antar slide dan efek animasi
Transisi-transisi slide menambahkan sebuah edge khusus pada sebuah presentasi dan
memperhalus transisi antar tiap slide.
® Menambahkan efek transisi
1. Klik pada slide yang dikehendaki. Transisi muncul ketika slide menampilkan
pergerakan pada slide ini.
2. Pada toolbox Slide Transition terdapat pada bagian Task di bagian kanan layar.
Pilihlah jenis transisi yang ingin digunakan.
3. Modifikasilah transisi slide yang meliputi kecepatan dan suara.
4. Tekan tombol Apply to All Slide.
5. Tekanlah tombol Play atau Slide Show untuk mencoba efek yang diberikan.

- ) - 69
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Tasks View

|| speed 1

> Master Pages

> Layouts

> Table Design

I Custom Animation

~ Slide Transition

Apply to selected slides

Mo Transition -
Wipe Up

Wipe Right

Wipe Left

Wipe Down v

Modify transition

A db

Sound [

Loop until next sound

Advance slide
On mouse click h

Automatically after |Osec -

i Apply to All Slides |

i Play ! | Slide Show |

al Automatic preview

Gambar 4.9 slide transition

® Menambahkan efek animasi

Setiap objek pada presentasi dapat diberi efek animasi yang dapat dinikmati saat slide

show. Untuk menggunakannya ikuti langkah berikut ini:

1. Klik objek yang akan diberi efek animasi.

2. Dari toolbox Custom Animation yang terletak di Task pada bagian kanan layar,

klik tombol Add dan akan muncul kotak dialog Custom Animation.

3. Atur efek animasi yang ingin diterapkan pada objek. Efek animasinya meliputi

Entrance, Emphasis, Exit, dan Motion Path yang terletak pada tab masing-

masing.

4. Tekan tombol OK.

5. Pada toolbox Efect Animation dapat diatur lagi mulainya efek animasi, arah, dan

kecepatannya (Start, Direction dan Speed).
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Tasks View - X

i Master Pages

B Layouts

b Table Design

¥ Custom Animation

el :
e BEION G )

Effect Fly In

Start On click ‘!
Direction |From bottom ‘!7 - .
Speed | very fast i

Sy = Outline Text 1: Microsoft Wind...

Chang?order: +* ¥ .

B Slide Transition

Gambar 4.10 efect animation

# Custom Animation

Entrance Emphasis Exit Motion Paths Misc Effects

Basic &

| Appear
Box
Checkerboard
Circle
Diagonal Squares
Diamond
Dissolve In b
Flash Once
Fly In
Fly in Slow
Peek In
Plus
Random Bars
Random Effects
Split
Venetian Blinds
Wedge
Wheel #
Speed Medium

& Automatic preview

Gambar 4.11 custom animation

4.6. Mengekspor tampilan slide sebagai format lain
Sayangnya, tidak semua komputer memiliki perangkat lunak libreoffice.org. Itulah
sebabnya terdapat beberapa pilihan yang membuat impress fleksibel dan dapat dilihat

pada platform virtual lain. Ada tiga fasilitas yang secara khusus berguna untuk

i L
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memenubhi hal ini: pilihan export as PDF, shockware, dan HTML.

® Mengekspor ke file flash

Sebuah format file flash (yang juga disebut shockware) (.swf) didasarkan pada

program flash, yang dibuat oleh macromedia. Untuk mengekspor sebagai sebuah file

(.swf):

1.
2.
3.
4,

pilih File > Export.

Pilih lokasi dan nama bagi file tersebut.

Pada File Format, pilih Macromedia Flash (.swf).
Klik Save

® Mengekspor ke file HTML

HTML atau Hyper Text Markup Language diwakili dengan ekstensi .htm.

Menyimpan presentasi dalam format ini memungkinkan pengguna untuk meng-

upload file-file ini ke internet sehingga dapat dilihat sebagai halaman web.

Karakteristik penting lainnya dari format ini adalah dapat dilihat oleh berbagai

macam platform aplikasi dan komputer.

Langkah-langkah untuk meng-export sebagai sebuha file HTML sebagai berikut:

72

. Pilih File > Export.
. Pilih lokasi dan nama bagi file tersebut.

1
2
3.
4

Pada File Format, pilih HTML Document (LibreOffice.org Impress)(.html;.htm).

. Jendela HTML Export akan muncul. Ini adalah panduan yang akan membantu

anda melakukan setup pada dokumen HTML tersebut. Ikuti panduan tersebut.
Jika masalah muncul, gunakan pilihan default, yang umumnya bekerja dengan
baik ketika menyimpan dalam format ini.

Klik Create untuk mengakhiri proses ini.
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Assign design

® New design

Existing design

I Delete Selected Design

Select an existing design or create a new one b

Ltele ] lnaneel ) | <<Back [ iNexezal | [create

Gambar 4.12 mengekspor dokumen presentasi ke html

ﬁ:r‘pl.ltlh
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